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FOREWORD 

Welcome to the world of Technical and Vocational Education and Training (TVET) in the 

hospitality and tourism sector. In an era of constant evolution and growing demand for skilled 

professionals, the importance of specialized training cannot be overstated. As the global 

hospitality and tourism industry continues to flourish, the need for competent individuals 

equipped with relevant knowledge and practical skills has become crucial. This collection of 

TVET training manuals serves as a comprehensive resource for those seeking to embark on a 

fulfilling career or further their expertise within the hospitality and tourism sector. Developed 

with meticulous attention to detail and in collaboration with industry experts, these manuals 

offer a wealth of knowledge, practical insights, and hands-on training exercises.  

 

The manuals cover a wide range of topics, ranging from essential foundational concepts to 

specialized areas within the industry. Whether you are interested in hotel management, 

culinary arts, event planning, travel and tourism, or any other facet of this vibrant sector, you 

will find invaluable guidance within these pages. At the heart of the TVET approach is the 

belief that learning should be both practical and relevant. These manuals have been carefully 

crafted to ensure that they reflect the real-world challenges and requirements of the 

hospitality and tourism industry. They are designed to empower learners with the skills, 

competencies, and confidence needed to excel in their chosen field. 

 

Furthermore, the manuals adopt a learner-centered approach, encouraging active 

participation, critical thinking, and problem-solving. Throughout each module, learners are 

encouraged to engage in practical exercises, case studies, and interactive activities that 

simulate real-world scenarios. This hands-on approach allows learners to apply theoretical 

concepts and develop the necessary skills that are highly sought after in the industry. 

We understand that education is a lifelong journey, and these manuals have been designed 

to cater to learners at various stages of their professional development. Whether you are a 

student taking your first steps in the industry, a working professional seeking to enhance your 

skills, or an instructor guiding aspiring individuals, you will find the manuals to be a valuable 

asset. 
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I would like to express my sincere appreciation to the authors, industry experts, and 

educators who have contributed to the creation of these TVET training manuals. Their 

dedication and expertise have ensured that the manuals are of the highest quality and 

relevance.  

I encourage you to embrace the opportunities presented within these pages, to explore the 
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INTRODUCTION 

 

Welcome to the training manual on computer literacy, designed for learners pursuing TVET 

level 3 in Rwanda. This manual is a comprehensive guide to computer basics and is structured 

into five units, each covering a critical aspect of computer literacy. These units include 

applying computer basics, using a current word processing package, using a current 

spreadsheet package, using current PowerPoint presentations, and using the 

internet/intranet (Outlook). 

This manual is designed to be an interactive learning experience, comprising discovery 

activities that encourage learners to explore and discover concepts, problem-solving activities 

that require learners to think critically and come up with solutions, guided practice activities 

that provide step-by-step instructions, and application activities that enable learners to apply 

their newly acquired knowledge in real-life situations. 

Additionally, this manual incorporates assessment activities that provide learners with 

feedback on their progress and help them identify areas where they need to improve. 

By the end of this manual, learners will have gained a comprehensive understanding of the 

key aspects of computer literacy, including applying computer basics, using popular word 

processing, spreadsheet, and presentation software, and effectively using the 

internet/intranet (Outlook). They will be equipped with the necessary skills to effectively use 

computers in any trade or economic sector. Let's get started! 
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 UNIT 1: APPLY COMPUTER BASICS 

 

 

Figure 1:Apply Computer Basics; https://edu.gcfglobal.org/en/computerbasics/basic-parts-of-a-computer/1/1 

  

                                                             
1 Citied by https://edu.gcfglobal.org/en/computerbasics/basic-parts-of-a-computer/1/# 
 

Unit summary: 

This unit describes properly computer basics where we define clearly the computer, 

naming correctly the different components of the computer, understanding clearly 

various connectors that are on different peripheral devices with their corresponding 

ports on the computer system, describing different computer operations, and 

explaining clearly the usage of desktop elements of different window versions. 
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Self-Assessment:  

1. Study the Figure 1: look, observe carefully and answer the following questions  

a. What do you see in the figure? 

b. How does the figure relate to the unit? 

c. Do you think the figure reflects the learning unit? Explain your answer briefly 

d. What can be improved in the figure so that it reflects the unit? 

e. What do you think will be topics to be covered under this unit based on the figure? 

2. Fill in and complete the self-assessment table below to assess your level of knowledge, 

skills and attitudes under this unit. Try to answer truthfully. It is for your own interest 

to figure out your weakness and take necessary action during this unit. Think about 

yourself: do you think you can do this? How well? Read the statements across the top. 

Put a check in the column that best represents your situation. At the end of this unit, 

you will take this assessment again.  

My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Define a computer      

Explain different computer 

parts 

     

Describe different 

computer components 

     

Explain types of computers      

Explain computer 

input/output device 
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My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Describe computer 

storages 

     

Explain computer 

processes 

     

Identify different storage 

devices and its function 

     

Describe the components 

of CPU and its functions 

     

Describe the use of icon in 

desktop 

     

Identify and apply the task 

bar and start menu  

     

Table 1:LU.1 Self-Reflection 

Key Competencies of Learning Unit 1 

Knowledge Skills Attitudes 

1. Define computer 1. Identify the 
composition of 
computer system 

1. Politely listen actively 
to the ideas  

2. List out different 
types of computers  

2. Describe different 
computer types  

2. Demonstrate 
effectively different 
types of computers  
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3. List out main part 
of computer  

3. Identify the main 
parts of the computer  

3. Respectively pay 
attention for 
clarification  

4. Define Connectors 
and Ports 

4. Describe connectors 
and ports   

4. Carefulness when 
connecting connectors 

5. List the difference 
of connectors and 
ports 

5. Identify the difference 
between connectors 
and ports 

5. Reading connectors 
and port requirements 
descriptions 

6. List out different 
types of Ports 

6. Identify different 
computer ports  

6. Carefulness when 
connecting connectors 
and ports 

7. Give the definition 
of Input 
Devices/Output 
devices 

7. Identify input/output 
devices 

7. Be focused and careful 

8. List all Storage 
devices 

8. Identify and describe 
different storage 
devices 

8. Careful when touch 
storage devices 

9. Define the 
computer CPU and 
its functionality 

9. Describe the CPU and 
its functions 

9. Understanding and 
focused to the CPU 

10. Describe the 
desktop and icons. 

10. Describe the use of 
icon in desktop 

10. Adaptable and 
understanding 

11. Describe task bar 
and start menu  

11. Identify and apply the 
task bar and start 
menu  

11. Carefully understand 
the task bar and start 
menu applications 

12. Explain the 
Minimizing, 
Maximizing and 
the close button 

12. Identify the minimize, 
maximize and closing 
button of the window 

12. Focused and carefully 
minise, maximize, and 
close the windows of 
various versions 

Table 2: LU.1 Key Competences 
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Discovery activity  

 

Figure 2:Basic computer parts; https://peda.net/kenya/ass/subjects2/computer-studies/form-1/the-computer-system2 

Task1:  

Clearly observe the above illustration and answer the questions below: 

a. What do you see on the above picture?  

b. Outline each component in the above picture 

 Task2:  

Think about the function of computer and where various components are connected with 

computer technologies and answer below questions; 

a. What does the word computer mean? 

b. Which computer components are used while entering data into computer? 

c. Have you seen any computer? Justify your answer. 

 

                                                             
2 Cited by https://peda.net/kenya/ass/subjects2/computer-studies/form-1/the-computer-system 
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Topic 1.1:  Description of the computer basics 

 Activity 1: Problem Solving 

 Task:   

Life has changed to digital, and computerization has a wide-ranging impact on day-to-day 

human activities. Considering how computers operate, come up with the answers to the 

following questions 

a. Which type of computers are mostly used today? 

b. What does PC mean in a computer system?  

c. Can more than one person use a single computer? 

 

Key Facts 1.1 

• Introduction to computer 

o Definition of computer: 

A computer is an electronic machine capable of manipulating data or 

information like text, sound, and images. It accepts data as input, process it 

and give the output in a very short time and it stores data for future use. 
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Figure 3:Parts of a computer; https://computerinfobits.com/parts-of-computer-and-their-functions/3 

A complete computer system is composed of three parts: 

 Hardware: refers to the physical parts or components of a computer such as the 

monitor, mouse, keyboard, computer data storage, hard drive disk (HDD), 

system unit etc. All of which are physical objects that can be touched. 

 Software: also called programs consists of organized sets of instructions for 

controlling the computer/ that invisible part of a computer that contains all 

programs and applications that are necessary to operate a computer. 

There are two types of software:  

A. Operating system: is the term used to describe programs that enable the 

computer to function, improve its performance and access the functionality of 

the hardware 

Examples: 

o An operating system (windows xp, windows 7,8,10, Linus, mac os) 

o BIOS program 

o Drivers Utilities program 

B. Application software: is the term used for programs that enable the user to 

achieve specific objectives such as create a document, use a database, produce a 

spreadsheet or design a building. 

Examples: 

o Web browsers (opera mini, Mozilla Firefox, google chrome, etc. 

o Adobe reader, Photoshop 

o MS word, MS excel, MS PowerPoint, etc. 

 
Human ware / user: The human ware component refers to the person that uses the computer. 

More specifically, it is about the individual that makes hardware and software components 

productive. 

 

                                                             
3 Cited by https://computerinfobits.com/parts-of-computer-and-their-functions/ 
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• Classification of computer  

Computers differ based on their data processing abilities. They are classified according 

to the size, purpose and data handling. 

o Types of computers according to the size: 

o Supercomputers: are the fastest, largest, most expensive and powerful 

computers available. They are able to perform many complex operations in a 

fraction of a second. Supercomputers are mainly used for scientific research, which 

requires enormous calculations. Some of the applications that justify use of 

supercomputers include aerodynamic design and simulation, petroleum research, 

defense and weapon analysis and telecommunications. Because of its weight, a 

supercomputer is kept in a special room. 

o Mainframe computers are less powerful and cheaper than supercomputers. 

While supercomputers may be described as giant computers, mainframes are said 

to be big in size. They are used for processing data and performing complex 

mathematical calculations. They have a large storage capacity and can support a 

variety of peripherals. Mainframe computers are used as powerful data processors 

in large research institutions and organizations such as banks, hospitals and 

airports, which have large information processing needs. 

o Minicomputers: are also known as small-scale mainframes because they were 

cheaper alternatives to mainframes computers. Like mainframes, minicomputers 

are used in business organizations, laboratories, research institutions, engineering 

firms and banks. 

o Microcomputers are the smallest, cheapest and relatively least powerful type of 

computer. It is called a microcomputer because its CPU is called a microprocessor, 

which is very small compared to that of minicomputers, mainframes and 

supercomputers. Microcomputers are commonly used in schools, business 

enterprises, cybercafé, homes and many other places. Today, the processing power 

of microcomputers has increased tremendously close that of minicomputers and 

mainframes 
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Description of types of personal computer:  

 

 
 Figure 4: types of personal computer; https://worldtechjournal.com/types-of-personal-computer/4 

 

o Desktop computer is designed so all of the components fit entirely on or 

under a desk or table. 

o Laptop computer: a small, portable computer small enough that it can sit on 

your lap. Nowadays, laptop computers are more frequently called notebook 

computers 

o A personal digital assistant (PDA): also known as a handheld PC, is a variety 

mobile device which functions as a personal information manager. Nearly all 

modern PDAs have the ability to connect to the Internet. A PDA has an 

electronic visual display, letting it include a web browser. Most models also 

have audio capabilities, allowing usage as a portable media player, and also 

enabling most of them to be used as telephones. 

o Types of computers according to the purpose  

 

According to purpose, computers are either general purpose or specific purpose. 

o General purpose computers are designed to perform a range of tasks. They 

have the ability to store numerous programs, but lack in speed and 

efficiency.  

o Specific purpose computers are designed to handle a specific problem or to 

perform a specific task. A set of instructions is built into the machine. 

                                                             
4 Cited by https://worldtechjournal.com/types-of-personal-computer/ 
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o Types of computers According to data handling 

 

According to data handling, computers are analog, digital or hybrid. 

o Analog computers work on the principle of measuring, in which the 

measurements obtained are translated into data. Modern analog computers 

usually employ electrical parameters, such as voltages, resistances or 

currents, to represent the quantities being manipulated.  

 

o Digital computers are those that operate with information, numerical or 

otherwise, represented in a digital form. Such computers process data into 

a digital value (in 0s and 1s). They give the results with more accuracy and 

at a faster rate.  

o Hybrid computers incorporate the measuring feature of an analog 

computer and counting feature of a digital computer. 

 Activity 2: Guided Practice 

Task:  

1. With your trainer guidance Label the following picture of computer hardware according 

to the letters 
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Figure 5: Hardware components of 5computer; https://www.docsity.com/en/computer-parts-labeling-worksheet/8797156/ 

Letters Name of components 

A  

B  

C  

D  

E  

F  

G  

H  

I  

J  

 Activity 3: Application 

Task:  

1. After knowing what computer is, different types and parts of computers, identify 

clearly the factors considered during classifying the types of computers.  

2.  Explain the main parts of computer? 

 

 

                                                             
5 Cited by https://www.docsity.com/en/computer-parts-labeling-worksheet/8797156/ 
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Topic 1.2:  Identification of various Connectors and ports 

 Activity 1: Problem Solving 

Task: 

1. Think about the functionalities of a computer without peripheral devices. Will it be able 

to give the best output during the time of operation? Clearly answer the following 

questions: 

a. What are computer peripherals? 

b. What do computers use to communicate with peripheral devices? 

c. With examples, list computer peripherals and explain how they work? 

d. Describe the communication between peripheral device and computers 

e. Where is the keyboard connected to computer?  

 

Key Facts 1.2 

 

• Connectors and ports 

o Definitions; 

o Connectors and ports on the computer allow it to communicate with many 

different devices and peripherals attached to it 

o Connectors: A computer cable connector is the part of a cable that plugs 

into a port or interface to connect a device to the motherboard or another 

device. Most connectors are either male (containing one or more exposed 

pins) or female (containing holes in which the male connector can be 

inserted). A number of different connector types are used to connect 

various external devices to the computer. 

o Ports: are endpoints at the back or side of a computer where you plug in an 

external device such as a printer, keyboard, scanner, mouse, or modem. This 

connection allows instructions and data to flow between the computer and 
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the device. These computer ports are also commonly referred to as the 

Input/Output ports (I/O ports). 

Types of ports 

 PS/2 port:  

o  

-  It has 6-pin female 

- It is used to connect mouse and keyboard to a computer 

 Green: connect mouse 

 Purple: connect keyboard 

 Serial port: 

 

 It has 9-pin male 

 It is used to connect old mouse and modem to a computer 

Parallel port:                             

 

 It has 25-pin female 

 It is used to connect a printer, a scanner to a computer 

VGA port: 

 

 VGA (Video Graphic Array) 

 It has 15-pin female 
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 It is used to connect a screen, a projector to a computer 

 USB port: 

 
 

USB (Universal Serial Bus) 

It is the most common port for connecting peripheral devices to a computer like: 

          Mouse                                Hard disk                          Modem 

   Keyboard                            Printer                               Scanner, etc. 

   Flash disk                            Digital camera                   

 Network port: 

 

 Also known as Ethernet port or RJ-45 port 

 It is used to connect a computer to the internet or network 

Audio port: 

 

 

It is used to connect microphone (for pink color), speaker, headphones (for 

green color), and audio mixers (for blue color) 

Digital Video Interface (DVI): 

 

 It has 24 female pins 
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 DVI is a high-speed digital interface between a display controller like a 

computer and a display device like a monitor 

HDMI (High-Definition Media Interface) 

 
 HDMI ports accept connections from HDMI cables, which transmit and receive 

high-definition audio and visual signals.  

 Computers, televisions and other multimedia devices often have HDMI ports to 

transfer images and sound onto another device 

 

https://digitalthinkerhelp.com/computer-ports-names-25-types-of-computer-ports-functions-examples/ 

https://www.geeksforgeeks.org/types-of-computer-ports/ 

https://www.javatpoint.com/computer-ports 

 Activity 2: Guided Practice 

Task: 

1. In a group of four trainees, with your trainer guidance, solve the following questions; 

a) Where do we find ports on the computer? 

b) Select different cables of peripheral devices and connect them to the computers 

c) Identify any four different ports name their functions 

d) Differentiate connectors from ports 

e) Describe the communication between computers and other peripheral devices 

2. As discussed in this chapter, today's typical ports and connectors identify the full name 

of these ports and what they are used for 
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https://www.eslprintables.com/vocabulary_worksheets/technologies/computers/Computer_Port_Exercise_768761/ 

Sn abbreviation Full name 

1   

2   

3   

4   

5   

6   

7   

8   

9   

10   

11   

12   
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 Activity 3: Application 

Task: 

Today's PCs have many different connections. In order to input information and have 

corresponding information outputted by the computer, all of the devices need to be 

connected to the correct ports. 

1. Examine your home (or lab) computer and identify the various ports associated with 

it. 

2. Make a quick sketch of the back of the computer.  
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Topic 1.3: Description of Computer Operations  

 Activity 1: Problem Solving 

Task: 

Having input and output devices that help users to share information with computers, this 

clearly shows us that having a computer alone is not enough. Computers require other 

materials and processes to provide output. Think about what we need to give to a 

computer and how information is stored. From that, answer the following questions 

a. What is the role of CPU in computer? 

b. Where data is temporarily stored in the computer? 

c. All what we do on the computer where is it stored?  

d. When we write anything on the computer where does it save it? 

e. When we switch off the computer that is stored data where can we find it? 

f. Does the computer still operate when primary memory is damaged?  

Key Facts 1.3 

• Peripheral devices: 

o There are three categories of Peripheral devices; 

o Input device: An input device is a piece of hardware used to provide data to a 

computer used for interaction and control. It allows input of raw data to the 

computer for processing.  

 

Here’s a list of some input devices used in computers and other computing devices: 

 Keyboard, one of the primary input devices used to input data and 

commands. It has function keys, control keys, arrow keys, keypad and the 

keyboard itself with the letters, numbers and commands. 

Keyboards are connected to the computer through USB or Bluetooth. A laptop  

keyboard is more compact than a desktop keyboard to make the laptop smaller and 

lighter.  
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6 Cited by https://technology.blurtit.com/584855/what-are-the-two-types-of-computer-keyboard 

Two versions of keyboard;  

 

 QWERTY keyboard 

 AZERTY keyboard 

The French version of the standard QWERTY keyboard.  

AZERTY keyboards differ from the QWERTY keyboard in that the Q 

and W keys have been interchanged with the A and Z keys.  

Another difference between QWERTY and AZERTY keyboard is that 

the M key on an AZERTY is to the left of the L key 

 
Figure 6:Types of Keyboards; https://technology.blurtit.com/584855/what-are-the-two-

types-of-computer-keyboard 
6 

o Mouse: an input device used to control the cursor and coordinates. It can be wired or 

wireless. It allows the user to do the following: 

o Move the mouse cursor 

o Select 

o Scroll 

o Open or execute a program 

o Drag-and-drop 

o Hover 
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o Perform other functions with the use of additional buttons 

o A laptop uses a touchpad as the mouse. A smartphone and tablet use a 

touchscreen as primary input device and the user’s finger is used as the 

mouse. 

o Microphone: an input device that allows users to input audio into their computers. 

Here are some uses of the microphone: 

o Audio for video 

o Computer gaming 

o Online chatting 

o Recording musical instruments 

o Digital Camera – is an input device that takes pictures digitally. Images are stored as 

data on memory cards. It has an LCD screen that allows users to preview and review 

images. Digital cameras have become popular over film cameras because of the 

following features: 

o LCD screen – allows users to view the photos and videos immediately 

o Storage – can store thousands of pictures 

o Picture development – allows users to choose and pick which pictures to 

develop 

o Scanner – is an input device that reads an image and converts it into a digital 

file. A scanner is connected to a computer through USB. 

o Touchscreen – is an input device that allows users to interact with a 

computer using their fingers. It is used widely in laptop monitors, 

smartphones, tablets, cash registers and information kiosks 
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• Output device: is a piece of computer hardware that receives data from a computer and 

then translates that data into another form. That form may be audio, visual, textual, or hard 

copy such as a printed document 

 

Note: The key distinction between an input device and an output device is that an input 

device sends data to the computer, whereas an output device receives data from the 

computer. 

 

Examples of Output Devices 

 

o Monitor – This is the most common computer output device. It creates a visual display 

by the use of which users can view processed data. Monitors come in various sizes and 

resolutions  

o Printer – this device generates a hard copy version of processed data, like documents 

and photographs. The computer transmits the image data to the printer, which then 

physically recreates the image, typically on paper 

o Speakers – speakers are attached to computers to facilitate the output of sound; sound 

cards are required in the computer for speakers to function. The different kinds of 

speakers range from simple, two-speaker output devices right the way up to surround-

sound multi-channel units. 

o Headset – this is a combination of speakers and microphone. It is mostly used by 

gamers, and is also a great tool for communicating with family and friends over the 

internet using some VOIP program or other 

o Projector – this is a display device that projects a computer-created image onto another 

surface: usually some sort of whiteboard or wall. The computer transmits the image 

data to its video card, which then sends the video image to the projector. It is most 

often used for presentations, or for viewing videos. 
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• Computer storage devices: A hardware device that is used to store digital data and 

applications which may be in the form of video, audio, images, etc. is known a storage 

device. It is a main component of a computer.  

There are two categories of storage devices; 

o Primary Storage Device: 

This is the direct memory which is accessible to the CPU or Central Processing Unit. 

● It is also called the main memory and is volatile. 

● This is temporary memory and is lost as soon as the device turns off or is 

rebooted. 

● It is small in size. 

● Primary storage consists only of Internal memory. 

● E.g., of primary storage: RAM, ROM, cache memory, etc. 

Table differentiating ROM from RAM 

Basis for Comparison RAM ROM 

Stands for Random Access Memory Read only Memory 

Memory type Volatile Non-Volatile 

Operation type Read and write both Only read 

Speed Fast Comparatively slow 

Storage type Temporary Permanent 

Secondary Storage Device: 
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Secondary storage is commonly used to store backup data that comes from primary 

storage. The data is copied from the primary storage system to the secondary storage 

system through the use of replication or other data protection and recovery techniques 

This type of storage does not have direct access to the CPU (Central Processing Unit). 

● The input and output channels help to connect such storage devices to the 

computer, as they are usually outside. 

● It is non-volatile with larger storage capacity compared to primary storage. 

● This type of storage is permanent until changed by an external 

● It consists of both internal and external memory. 

● E.g., of secondary storage:  USB drives, floppy disks, and more 

o Process device: 

The processing device is the computer’s hardware component that helps to handle the 

storage and retrieval of the information. In the Computer, processing devices play a 

major role in the processing operations. These devices are used to process the data with 

the use of instructions from the program. 

Examples of Processing devices are; 

● Processor/CPU 

● GPU (Graphics Processing Unit) 

● Motherboard 

o Central processing unit (CPU) 

Also referred to as processor, is a piece of hardware that carries out the instruction of a 

computer program. It performs the basic arithmetical, logical and input/output 

operations of a computer system. 

The CPU is like the brain of the computer; every instruction no matter how simple it is, 

has to go through the CPU. If you press a letter A on your keyboard and it appears on 

the screen, the CPU of your computer is what makes this possible. 
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7 Cited by https://resources.sei.cmu.edu/asset_files/TechnicalReport/2004_005_001_14387.pdf 

 
Figure 7: Block diagram of computer system; 
7https://resources.sei.cmu.edu/asset_files/TechnicalReport/2004_005_001_14387.pdf 

In the CPU, there are two primary components 

o Control Units (CU) 

The CU provides several functions: 

● It fetches, decodes and executes instructions 

● It issues control signals that control hardware 

● It moves data around the system 

o Arithmetic logic unit 

The ALU has two main functions: 

● It performs arithmetic and logical operations (decisions).  

● The ALU is where calculations are done and where decisions are made. 

● It acts as a gateway between primary memory and secondary storage. 

●  Data transferred between them passes through the ALU. 

o Registers 

Registers are small amounts of high-speed memory contained within the CPU. They are 

used by the processor to store small amounts of data that are needed during 

processing, such as: 

● The address of the next instruction to be executed 

● The current instruction being decoded 

● The results of calculations 
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 Activity 2: Guided Practice 

Task: 

1. A supermarket self-checkout has a range of input and output devices.  

a. Identify any input and output devices that the checkout might use, clearly stating  

b. which is an input, output or both 

c. Describe the purpose of each device 

2. Used alone the IT term 'storage' applies to secondary storage. Briefly describe four 

devices commonly used in business systems for storage. 

3.  If you are given a task to innovate a new input device and output device, what do you 

think of and why? 

4. A washing machine has a small displaying screen built into it; one use of the display 

screen is to show an error code when a problem Has occurred within the washing cycle 

5. For any clarification or problem request the trainer assistance  
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 Activity 3: Application 

Task: 1 

1. A doctor in a hospital requests your assistance. She is using a computer to register 

patients' identifications and their sickness status. Additionally, she asks for a copy of their 

insurance to be kept on her computer. Afterward, she gives out the report to her 

supervisor on paper 

a. Name computer devices he is using? 

b. Identify Input devices from Output devices he’s using? 

c. There are also be various output devices. Identify some that may be used and 

explain their purpose? 

d. Hannah is an artist who is beginning to use computers for her drawings, what input 

device would you recommend and why? 

2. Ange loves loud music but still lives at home with his mum and dad what output device 

would you recommend him to use? 

3.  How do computers use input and output to get and give the information that they need 

to solve problems? 

4. Connect all input devices, output devices to the computer and switch on the computer 

and see if it displays anything. 
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Topic 1.4 Description of Elements of the Computer 

 Activity 1: Problem Solving 

Task:  

Think about the computer desktop and its elements and answer below questions about the 

life before computer   were used; 

1. Which is the most common icon you see on desktop when you turn on the computer? 

2. Where should you click to navigate into the window element? 

3. I want to change the time and date, where should I click? 

Key Facts 1.4 

• Using of desktop’s elements  

o Windows and its elements 

Desktop is part of the computer’s operating system and is usually a graphical user 

interface or ‘GUI’ that enables a user to access data files, programs and storage drives 

amongst other things. All these items are displayed as icons on the desktop.  

The examples given in this topic use Windows 10 as the operating system. 

 
Figure 8: Window 10 desktop; 

https://www.tutorialspoint.com/basics_of_computer_science/basics_of_computer_science_windows_desktop_elements.htm8 

                                                             
8 Cited by https://www.tutorialspoint.com/basics_of_computer_science/basics_of_computer_science_windows_desktop_elements.htm 
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As you can see in the above image, in the left bottom, there is a window symbol (i.e., 

menu button); once you click on it, the given menu option will appear and from here 

you can choose your option. 

After starting Windows, the first background one sees is called desktop.  

o Desktop  

Desktop is the layer on top of which you run all your computer programs. 

 It contains icons, shortcut icons and taskbar. 

● Icons: are small pictures, images used to represent a file, folder or a program on 

the computer. 

● Shortcut icon: is a tiny file, folder or program with small white box and arrow on 

the left corner which just represents a program but is not the program itself. 

Common icons on desktop are: 

● Computer  

● Recycle Bin 

● Internet Explorer or Mozilla Firefox 

● Task bar is the long horizontal bar located at the bottom of the desktop that 

helps to manage the various currently active programs opened in different 

windows. 

o Taskbar 

The taskbar allows a user to: 

● locate and launch programs through the start button,  

● see any program that is currently open, 

●  display the time or date 

A taskbar is divided into 3 sections: 

● The Start button , which opens the Start menu.  

● The middle section, which shows you which programs and files you have opened 

and allows you to quickly switch between them. 

● The notification area, which includes a clock and icons (small pictures) that 

communicate the status of certain programs and computer settings. 
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o Start Menu 

Start Menu: It is divided into two panes-left pane and right pane. The left pane is used 

to access programs or to search files/ folders in the computer and the right pane gives 

access to some common folders like Documents, pictures, music et 

The following lists down describe the options that appear after clicking on the Start 

menu  

All programs 

It displays all those programs, which are installed in your system. 

Document 

It displays a list of folders used by the user. 

Recent file 

It displays the recently used file. 

My picture 

It displays a list of pictures. 

My music 

It displays a list of music/song, etc. 

My computer 

It displays the drives of computer where user keeps his/her work, file, folder, song, 

video, picture, e-book, etc. 

Control panel 

It displays all the installed computer programs (software). 

Search 

It helps a user to find a file in computer 

Run 

It helps to start an application program or execute a DOS command 

Setting 

It has different options that help to manage different settings of the computer, software 

as well as hardware 

Log Off 

It helps a user to log off the currently logged in user of the system. 

Sleep 
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It makes the system non-functional; however, puts the ongoing work and settings in 

memory and also keeps drawing small amount of power. 

Hibernation 

Hibernation puts the open documents and programs on hard disk and then turns off 

your computer; in comparison to ‘sleep’, it uses very low power. 

Restart 

Its function is to shut down and again start (log on) computer; it is done normally to 

refresh computer especially when computer is hanged. 

Shut down 

It simply shuts down the system. 

Note − Depending on the version of your window, the menu option may vary in terms 

of appearance and number of menu options; however, there would not be any change 

in basics. 

o Minimize, maximize, close buttons 

● Minimize / Maximize Button: Small buttons, usually located in the upper right 

corner of the window's title bar (optional feature). When activated, these 

buttons reduce the window to an icon or enlarge the window to its largest 

supported size, respectively. 

● Close Button:  Pressing this button is just one way of closing the window, and it's 

the easiest. But take caution on dialog boxes: when this button is active, it 

usually has the same effect as pressing the "CANCEL" button, so be sure you 

don't need to save any changes you made in the dialog box. Other ways of 

closing the window include double-clicking the control menu or clicking on the 

File menu and then Exit if it's an application window, and clicking on the 

"OK" button if it's a dialog box. 

https://www.tutorialspoint.com/basics_of_computer_science/basics_of_computer_science_windo

ws_desktop_elements.htm 
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 Activity 2: Guided Practice 

Task:  

You are working for a company, and you are supposed to provide support for all your 

workmates who have problems with their computers. Then, one of your coworkers asks for 

your help with the following tasks that show the problems. You are asked to solve them but 

also to request guidance from your trainer if needed? 

a. I've lost my Windows taskbar; how do I get it back? 

b. My taskbar moved to the left, top, or right side of the screen. How can I restore it? 

c. I can’t find the minimizing/maximizing button how can I solve the issue 

d. All icons on the desktop have disappeared. How can I bring them back? 

e. How do I enable or disable the taskbar auto-hide on my computer? 

f. My folder called music has been deleted from desktop by accident how can I restore 
it? 

 Activity 3: Application 

Task: 

John tried to search for his marks folder, but all the icons on the desktop were too small. 

He didn't know how to increase the size of the icons. After John added a folder of images 

to his desktop, he realized the computer was running Windows 7. When he tried to open 

the folder, he found that it was just a shortcut and couldn't find the actual files. Since it 

was John's first time using a computer, he failed to install an application software. Based 

on this scenario, answer the following questions 

a. Describe and follow the steps that John would use to increase the size of the icons? 

b. What is the advice you can give to John when he found that folder was a shortcut and 

can’t find anything?  
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 Formative Assessment of Unit 1  

1. Most inkjet, laser, and thermal printers use this interface to connect a printer to a 

computer. (Choose two.) 

a. RJ-45 

b. USB 

c. Parallel 

2. Identify three types of video connectors. 

a. VGA type 

b. DMI type 

c. HDMI type 

d. USB type 

3. You are in the process of installing a new keyboard to a new PC. Which of the 

following is the most common type of connector to use? 

a. Serial connector 

b. PS/2 connector 

c. USB connector 

d. IEEE1394 connector 

4. _________ key is used to come out of add mode? (a) o (b) - (c) esc (d) ctrlRJ 

5. Connectors are found on the back of computer 

a. True 

b. False 

6. When a user starts a computer, portions of the operating system load into the 

computer's hard disk from memory 

a. True  

b. False 

7. User communicates with a computer with the help of which devices? 

a. Input device 

b. Output device 

c. Both a and b 

8. Which of the following groups are only input devices? 
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a. Mouse, keyboard, Scanner, Joystick, Light pen 

b. Mouse, keyboard, Trackball, Touch Screen, Microphone 

c. Both a and b 

9. Which input device is used for input text, numbers, and commands to the computer? 

a. Mouse 

b. Keyboard 

c. Scanner 

10. The number of function keys in a keyboard is 

a. 14 

b. 12 

c. 13 

11. All files which are deleted from computer are stored in 

a. recycle bin 

b. temporary files 

c. my documents 

12. Computer mouse event is 

a. left click 

b. Double click 

c. Right click 

d. All the above 

13. Pressing the Print screen key on your keyboard takes a 'picture' of what is displayed 

on the screen 

a. True 

b. False 

14. Computers process information (output) into data (input). 

a. True 

b. False 
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Points to Remember of Unit 1 

• Always read user manual of computer 

• Switch off the computer after use 

• computer must be comfortable and fixed in a safe place 

• Always add files in folders to have space 

• Write the names of icons well to remember them 

• Always empty the recycle bin to add space to your computer 

• Use strong passwords to secure your information 

Table 3: Points to Remember of Unit 1 

Self-Reflection: Learning outcome 1 

 

Reflect on your achievement in the above learning Unit, base your reflection on activities 

done and your performance.  

My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Define a computer      

Explain different computer 

parts 

     

Describe different 

computer components 

     

Explain types of computers      
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My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Explain computer 

input/output device 

     

Describe computer 

storages 

     

Explain computer 

processes 

     

Identify different storage 

devices and its function 

     

Describe the components 

of CPU and its functions 

     

Describe the use of icon in 

desktop 

     

Identify and apply the task 

bar and start menu  

     

Table 4:Self-Reflection LU.1 
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Fill the table below to identify your areas of strength, areas for improvement and actions to 

take to improve. 

 Table 5:LU.1 Strength and Improvements 

  

Areas of strength Areas for improvement Actions to be taken to 

improve 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 
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UNIT 2: USE A CURRENT WORD PROCESSING PACKAGE 

 

Figure 9: Illustration of MS Word; https://commons.wikimedia.org/wiki/File:Microsoft_Word_2013-2019_logo.svg 

 

Unit summary: 

Microsoft Word is a word processing software package. You can use it to type letters, 

reports, and other documents. This unit properly describes word processing where we 

clearly define all the processes of creating word document, editing document, saving 

document and printing the document. 

 

Self-Assessment: Unit 2 

1. Study the Figure 1: look, observe carefully and answer the following questions 

a. What do you see in the figure? 

b. How does the figure relate to the unit? 

c. Do you think the figure reflects the learning unit? Explain your answer briefly 

d. What can be improved in the figure so that it reflects the unit? 

e. What do you think will be topics to be covered under this unit based on the figure? 

 

2. Fill in and complete the self-assessment table below to assess your level of knowledge, 

skills and attitudes under this unit. Try to answer truthfully. It is for your own interest to 

figure out your weakness and take necessary action during this unit. Think about yourself: 
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do you think you can do this? How well? Read the statements across the top. Put a check 

in the column that best represents your situation. At the end of this unit, you will take 

this assessment again. 

My experience I don’t have 

any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Define a MS word      

Differentiate MS Word 

screen elements 

     

Explain different text 

formatting options 

     

Explain different 

paragraph formatting 

options 

     

Describe how you can 

create and edit table 

     

Describe how to edit a 

document 

     

Explain how to insert 

Footnotes, footers, and 

headers 

     

Describe automatic page 

numbering   
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My experience I don’t have 

any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Explain how to know the 

total number of pages 

     

Describe file 

management 

     

Create files and folders      

Name files and format 

them 

     

Describe page setup      

Explain the detailed 

printer options 

     

Printing one or more 

copies 

     

Table 6:LU.2 Self-Assessment 

Key Competencies of Learning Unit 2:  

Knowledge Skills Attitudes 

1. Describe text 

formatting 

1. Apply text formatting v Attentively apply text 

formatting  

2. Describe paragraph 

formatting 

2. Apply paragraph 

formatting 

v Focused apply 

paragraph formatting 
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3. Explain how to insert a 

table 

3. Follow the steps for 

inserting a table into a 

word document 

v Carefully insert a table 

into a word document 

4. Explain inserting a 

column and a row 

4. Apply column and row 

insertion to the table 

v Attentively insert 

columns and rows in 

the table 

5. Describe how to merge 

a file and delete a 

table 

5. Follow appropriate 

steps in problem 

solving 

v Carefully follow the 

appropriate steps of 

file emerging and 

deleting a table from 

a certain document 

6. Explain document 

editing 

6. Use communication as 

a tool for problem 

solving 

v Understanding clearly 

more styles of 

document editing  

7. Describe Header, 

footer and footnote 

insertion 

7. Follow different steps 

of inserting Header, 

footer and footnote 

v Carefully follow the 

steps of inserting 

Header, footer and 

footnote 

8. Explain page saving 

and printing 

8. Follow procedures of 

saving and printing a 

page 

v Carefully follow saving 

and printing 

procedures 

Table 7:LU.2 Key Competences 
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Discovery activity 

 

Figure 10: https://www.computerhope.com/issues/ch000829.htm/9 

Task:1.  

When creating a Word document, you must try your best to make it look good in 

order to attract the reader. Various font changes must be done; most of the 

document needs to have clear formatting, font size, and color to help the reader 

differentiate titles, subtitles, and content. Carefully study the figure above and 

answer the questions below; 

a. What is the use of Font size in the illustration above? 

b. What is the use of Font Color in the above illustration? 

c. When you need to change the font style how do you do it? 

d. Is formatting word document important explain why? 

e. Write down all your answers 

                                                             
9 Cited by https://classnotes.ng/lesson/wordprocessing-ss2/ 
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Topic 2.1: Formatting text with Font Size, Style and Colors 

 Activity 1: Problem Solving 

Task:  

1. You are creating an MS Word document, and you want your document to have the colors, 

font style, and font size you desire. Read the problem carefully and answer the following 

questions. 

a. Which MS word element you can use to change text color to red? 

b. Which MS word element you can use to font size to 14? 

c. What does the status bar help us in MS word? 

d. What does Ribbon help us with in MS word? 

 

Key Facts 2.1 

• Formatting Text 

Formatted text can draw the reader's attention to specific parts of the document and 

help communicate your message. This topic shows how to format the font size, style, 

and color of text, as well as how to use the bold, italic, underline, and change case 

commands. 

• Applying Font size 

          Steps 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font size box on the home tab. 

 The font size drop-down menu appears.  

  Move your cursor over the various font sizes. 
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  A live preview of the font size will appear in the document. 

 Left-click the font size you want to use.  

 The font size will change in the document 

• Applying Font Style 

       Steps 

 Select the text you want to modify. 

 Left-click the drop-down arrow next to the font style box on the Home tab. 

  The font style drop-down menu appears. 

 Move your cursor over the various font styles.  

 A live preview of the font will appear in the document. 

 
 Left-click the font style you want to use.  

 The font style will change in the document. 

 

•  Applying Font color 

      Steps 

 Select the text you want to modify. 
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 Left-click the drop-down arrow next to the font color box on the Home tab. 

  The font color menu appears. 

 Move your cursor over the various font colors. 

 A live preview of the color will appear in the document. 

  
 Left-click the font color you want to use.  

 The font color will change in the document. 

 Your color choices aren't limited to the drop-down menu that appears. 

  Select More Colors at the bottom of the list to access the Colors dialog box. 

Choose the color you want, and then click OK. 

• Applying bolding, italic, and underlining commands: 

        Steps 

 Select the text you want to modify. 

 Click the bold, italic, or underline command in the Font group on the home 

tab. 

 

• Applying Text effects 

         Steps 

 Select the text you want to modify. 
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 Click the Change Case command in the Font group on the home tab. 

 Select one of the case options from the list. 

 

• Applying Text change case 

• Insert subscript or superscript text 

Superscript and subscript refer to numbers that are positioned slightly higher or slightly 

lower than the text on the line. For example, chemical formulas use subscript (H2O), 

and an exponent is often formatted as a superscript (X4). 

 Select the text that you want to format as subscript or superscript. 

 Do one of the following: 

 On the Home tab, in the Font group, click Subscript. Or press  

CTRL+=. 

 On the Home tab, in the Font group, click Superscript. Or press 

CTRL+SHIFT+=. 
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https://www.slideshare.net/marvieiloro/activity-parts-of-microsoft-word-window 

https://www.vskills.in/certification/tutorial/ms-word-window-elements/ 

 Activity 2: Guided Practice 

Task:  

1. A student is working with a Word document and trying to add some formatting and styles. 

They are looking at the MS Word interface, wondering about all the tabs and what they 

are used for. Read and answer the following questions to help this student: 

a. What does status bar help in MS Word? 

b.  What does ribbon help in MS word? 

c.  How do we use text area? 

d.  How can you use vertical and horizontal scroll bar? 

e.  What does title bar help for in MS word? 

2. A paragraph in Word is any text that ends with a hard return. You insert a hard return 

anytime you press the Enter key. Paragraph formatting lets you control the appearance if 

individual paragraphs. For example, you can change the alignment of text from left to 

 To undo the formatting, click the Subscript or Superscript button again, or 

repeat the keyboard shortcut. 

• Applying Format painter 

With format painter, you can copy all of the formatting from one object and apply it to 

another one. 

Steps 

To apply the Format Painter tool: 

 Select the text that has the formatting you want to copy. 

  Click once on the Format Painter tool.  

 Select the text you want to apply the formatting to. 

  The characteristics will be applied automatically. 
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center or the spacing between lines form single to double. You can indent paragraphs, 

number them, or add borders and shading to them. 

a. Re-write the paragraph above 

b. Open the Paragraph menu. Highlight all existing text (if applicable). Select Single from 

the Line Spacing drop-down menu. Set the Before and After spacing to 0 pt. Check 

the box next to don’t add space between paragraphs of the same style. Click OK 

c. Align the paragraph as justified 

d. Remove any font formatting (i.e., bold, italicized, underlined, or highlighted text). 

 

 Activity 3: Application 

Task:  

1. You are a supervisor at a certain hotel, but recently, due to COVID-19, the hotel was 

closed. The manager requests you to write a letter to the responsible Ministry, asking for 

the re-opening of the hotel, stating that all precautions to prevent the spread of the 

disease have been put in place. Design a good, smart, and readable letter and apply text 

formatting where necessary. 

2. John is a client at a cyber cafe, and he wants to write an application letter for a job. He 

came to the cyber cafe where you work and asked for your help in writing the letter. Use 

standard font size, font style, and color appropriately for the application letter: 

a) Create new file, to write letter for John? 

b) Save created file under the name of “john application letter” 

c) Add address to the letter 

d) Add title of the letter and underline 

e) add body of the letter  
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Topic 2 :2: Formatting Paragraphs 

 Activity 1: Problem Solving 

Tasks: 

1. Creating a MS word document, you want your document to have a different color, style 

and size; carefully answer the following questions; 

a) Where do you go to change the color, size and style? 

b) How do you change the color? 

c) Can we make the characters bigger than what we see if yes? 

d) How can we do so 

e) How can we space what we are writing? 

 

Key Facts 2.2 

o Change text alignment  

Steps 

• Select the text you want to modify. 

• Select one of the four alignment options from the Paragraph group on the home 

tab. 

o Align Text Left: Aligns all of the selected text to the left margin 

o Center: Aligns text an equal distance from the left and right margins 

o Align Text Right: Aligns all of the selected text to the right margin 

o Justify: Aligns text equally to the right and left margins; used in many 

used in many books, newsletters, and newspapers 
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o Working with column 

Steps 

• To set the number of text columns on a page,  

• you use Word’s Columns command:  

• Click the Layout tab, and in the Page Setup group, click the Columns button. 

•  A menu appears, listing common column-formatting options, as shown on the 

left here. 

 

 
o Inserting Symbols 

Steps 

To insert symbols, 

• Click the Symbol button see some popular or recently used symbols. 

•  Choose a symbol from the menu to insert the special symbol directly into your 

text 
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o Bullets and numbering     

Steps 

To create numbered lists, follow these steps:         

• Type your list, and then select it. 

• Do one of the following:  

• On the Home tab, in the Paragraph group, click Bullets or Numbering. 

 

  
   You can find different bullet styles and numbering formats by clicking the arrow next 

to Bullets or Numbering on the Home tab, in the Paragraph group. 

o Applying borders and shading 

Steps 

• Click the Home tab. 

•  In the Paragraph group, click the triangle by the Borders button to display the 

Borders menu. 

•  Choose the Borders and Shading command.  

• The Borders and Shading dialog box appear, as shown here 
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o Line and paragraph Spacing: 

Steps 

It is used to choose how much space appear between line of text or between paragraph. 

• Go to Home  

• Line and Paragraph Spacing 

• Then choose Line Spacing Options 

 

https://uomustansiriyah.edu.iq/media/lectures/6/6_2018_12_18!09_55_26_PM.pdf 

https://www.dickinson.edu/download/downloads/id/3966/word 

https://edu.gcfglobal.org/en/word/line-and-paragraph-spacing/1/ 

Activity 2: Guided Practice 

 Task:  

1. As discussed in this Unit, you are going to examine the figure bellow and name each 

number according to selected part. 
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Sn Full name 

1  

2  

3  

4  

5  

6  

7  

8  

9  

10  

11  

 

2. With your trainer guide do self-assessment through reading these sentences and 

understand well what each mean 

a. What does status bar help in MS Word? 

b.  What does ribbon help in MS Word? 

c. How do we use text area? 

d. How can you use vertical and horizontal scroll bar? 

e. What does title bar help for in MS word?? 
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 Activity 3: Application 

Task: 

1. Trainees will observe any activity (at workplace, at school, or home) which requires the 

use of Microsoft word; describe how MS word is effective to the users? 

2.  John is a client at a cyber cafe, and he wants to write an application letter applying for a 

job. He came to the cyber cafe where you work, and you were asked to help John write 

the letter using standard font size, font style, and color appropriately for an application 

letter, including any necessary formatting  

a. Create new file, to write letter for John? 

b. Save created file under the name of “john application letter” 

c. Add address to the letter 

d. Add title of the letter and underline 

e. Add body of the letter  

3. Groups will present their reports which will be discussed on 
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Topic 2.3:  Creating and Editing a Table 

 Activity 1: Problem Solving 

Task: 

1. You are an intern at a certain TVET school, and you are given a task to help a certain head 

of the sector make an Excel sheet for the second term after marking quizzes, 

assignments, and assessments; 

a. Design the excel sheet and give it a name ‘Second Term Marks’? 

b. Insert columns corresponding to the modules that were done 

c. Insert the marks in the corresponding modules 

 

Key Facts 2.3 

o Create table  

A. Creating tables of various sizes and styles in Word can be useful when 

financial or numerical information and written text need to be 

presented in the same document. Word allows you to insert simple 

tables, pre designed tables and complex, customizable tables like 

calendars in a document10. 

 

                                                             
10 https://www.javatpoint.com/to-insert-table-in-ms-word 
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To create table, you can use one of the three commands shown above (1, 2 and 3). 

Steps:  

 Click Insert tab 

 Tables group and choose one of the commands like Draw table or Insert 

table 

o Inserting a column and a row 

 Insert a column 

Move the mouse cursor inside the left edge of a cell in the column where you 

want to insert a new column. The cursor changes to a small black arrow 

pointing to the top-right. 

Using your mouse, right-click to open the pop-up menu, select Insert, then 

select Insert Columns to the Left or Insert Columns to the Right, depending 

where you want the row  

 inserted. 

 Insert a row 

Move the mouse cursor inside the left edge of a cell in the row where you 

want to insert a new row. The cursor changes to a small black arrow pointing 

to the top-right. 

Using your mouse, right-click to open the pop-up menu, select Insert, then 

select Insert Rows Above or Insert Rows Below, depending where you want 

to insert the row. 

 Add / delete cells 

To add or delete cells you right click where you want to add or delete cells in 

the table 

Insert then choose the way you want cells to be inserted: Insert columns 

above, Insert rows below, 

 Delete Table 



57 
 

To remove rows, columns or a table you select them and right click, choose 

delete rows, columns but for a table you press Backspace key.  

 Merging cells 

To extend content across multiple rows or columns in a table, merge cells to 

create a larger cell. Or, split cells into smaller cells. 

Steps for merging cells 

§ Select the cells that you want to merge. 
§ Select Layout  
§ Merge Cells. 
§ To unmerge cells, select the cells and select Unmerge Cells. 

Note: In Excel, select the cells you want and select Merge & Center. To unmerge 
cells, select the cells and select Unmerge Cells. 

 
Splitting cells and drawing a table 
Steps: 

§ Click in a cell, or select multiple cells that you want to split.  
§ Under Table Tools, on the Layout tab, in the Merge group,  
§ click Split Cells.  
§ Enter the number of columns or rows that you want to split the 

selected cells into. 

Split a cell means increasing the capacity of a cellular system by subdividing or splitting 

cells into two or more smaller cells. 

Steps 

Split tables if you want your data separated into two tables.  

§ In the row that you want to be first in the new table, 

§  select a cell.  

§ Select Table Tools Layout  

§ Split Table.  

Note: If the new table contains multiple rows, it can also be split. 
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 Activity 2: Guided Practice 

Task: 

B. As discussed in this chapter, you are going to examine the figure bellow 

and name each number according to selected part. 

 

Figure 11:Inserting Table https://www.javatpoint.com/to-insert-table-in-ms-word11 

 

Sn Description 

1  

2  

3  

 

 Activity 3: Application 

                                                             
11 Cited by https://www.javatpoint.com/to-insert-table-in-ms-word 
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Task: 

1. Create a table for recording the marks of first term, then perform the following : 

 

a. Create column for name of the course, marks for quiz, cat and exam? 

b. Add column quiz, cat and exam under 1st term column span 

c. Update words, phrases, and formatting that appear multiple times throughout 

your document quickly & easily?  
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Topic 2.4 Editing Documents (Text)  

 Activity 1: Problem Solving 

Task: 

1. Vicky has put together a comprehensive training program for using her company’s 

corporate email. Her boss points out that she has been inconsistent with her spelling 

of email/e-mail and instructs her to use “e-mail” exclusively. How can Vicky, using find 

and replace, replace “email” with “e-mail” in her document? 

 

2. Ronald is searching for all instances of the word "and" to double-check that he has 

correctly applied the Oxford comma in his Ethics 101 assignment. Unfortunately, he 

keeps getting matches for longer words containing the letters "and," such as "land," 

"candy," and "aggrandizing." Which advanced search option must Ronald enable to 

filter out these false matches? 

 

Key Facts 2.4 

• Search/Find, replace 

Find and replace helps you to find words or formats in a document and can let you 

replace all instances of a word or format. 

Steps 

 Use Find and Replace, use the shortcut CTRL or navigate to Editing in the 

Home tab of the ribbon,  

 then choose Replace.  

 To just quickly find something, use the shortcut Ctrl+F  

You can also navigate to Home>Editing>Find.          
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 Enter the word or phrase you want to locate in the Find box. 

 Enter your new text in the Replace box. 

 Select Find Next until you come to the word you want to update. 

 Choose Replace. To update all instances at once, choose Replace All. 

To specify only upper or lowercase in your search, select More > Match case. 

o  Deleting a range of text   

Step 1 

 Select the first paragraph to be deleted by Triple-clicking it or Double-

Clicking in the left margin adjacent to that paragraph.  

 Scroll as necessary to view the last paragraph to be deleted. 

  Hold the Shift key while clicking in that paragraph.  

 Press the delete key. 

Step 2 

Suppose you have a document of 50 pages and you want to delete pages 10 to 15. You 

may wonder if there is a way to delete that range with a single action. 

 Press F5. Word displays the Go to tab of the Find and Replace dialog box. 

The Pages option should be selected, by default, at the left of the dialog box. 

 Type 10 into the Enter a Page Number box and then press Enter. Word jumps 

to the beginning of page 10. 

 If the Find and Replace dialog box doesn't go away on its own (it will in some 

versions of Word), press Esc. 

 Press F8. This turns on Extend mode. 

 Press F5. Word again displays the Go to tab of the Find and Replace dialog 

box. 

 Type 16 into the Enter a Page Number box and then press Enter. Word jumps 

to the beginning of page 16, but selects everything from the last insertion 
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point location because you are using Extend mode. This means that you now 

have everything on pages 10 through 15 selected. 

 If the Find and Replace dialog box doesn't go away on its own (it will in some 

versions of Word), press Esc. 

 Press the Delete key 

o Undo & Redo command 

The Undo command allows you to discard the most recent change in Quantum Visualizer. 

 The Redo command reverses the most recent change made using Undo. 

 To undo an action,  

 On the Edit menu,  

 click Undo, or press Ctrl + Z.  

To redo an action,  

 On the Edit menu, click Redo,  

 or press Ctrl +Y 

 

  Activity 2: Guided Practice  

Task: MS-Word 

 Microsoft Word is a word processor developed by Microsoft. It was first released in 1983 

under the name Multi-Tool Word for Xenix systems. MSWord is a popular word-processing 

program used   primarily   for   creating documents such as letters, brochures, learning 

activities, tests, quizzes and students' homework assignments. There are many simple but 

useful features available in Microsoft Word to make it easier for study and work. That's why 

so many people would prefer to convert the read-only PDF to editable Word and edit PDF in 

Word. 

a. Create a new file using new option. 

b. Select some part of your document of PRACTICAL -1 and copy it to new file created in  

c. bullet 1. Use shortcut keys for copy and paste. 
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d. Highlight “Microsoft Word is a word processor developed by Microsoft.” 

e. Search for word “document” using find option. 

f. Replace the word “Microsoft” with “MS 

g. Create a new file using new option. 

h. Select highlighted part of your document and copy it to new file created in bullets  

i. Use shortcut keys for copy and paste. 

j. Highlight “Microsoft Word is a word processor developed by Microsoft.” 

 

 Activity 3: Application 

Task:   

1. You are a worker in a certain hospital, and there are various medicines that you 

have been using, but unfortunately, those medicines have expired. You need to 

replace them urgently, including both the codes and their names. How can you 

solve that issue?  

2. The supervisor also requests you, in another document, to update the patient lists 

of those who have been admitted and recovered. How can you go through it 

quickly because it is a list of one million and five hundred fifty-six patients? 

 

3. The pediatrician doctor had received all information about Baby Joan's sickness, 

including the results of the blood test, body temperature, stool test, and body 

weight. However, accidentally, he clicked somewhere and lost all the information. 

Which steps can he follow to bring back all the information of Baby Joan?                               
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Topic 2.5:  Headers and Footers 

 Activity 1: Problem Solving 

Task:  

1. You are creating a Word document, and you want to add page numbers. What will 

happen if you type the page number in the header or footer by yourself from the 

keyboard? (Select right answer) 

a. You will see the page number incrementing from your typed number to the 

last page. 

b. You will get whatever number you typed repeatedly on every page. 

c. Page number will not be added in the document? 

 

Key Facts 2.5 

• Inserting Header and Footer 

Headers and footers are text (or graphics) which appear at the top or bottom of every 

page in a document. Or simply are areas within top and bottom margins. 

 

Headers and footers are used for a variety of purposes such as: 

o Page numbering 

o Document titles or Company name 

o Graphics (Company logo, ClipArt) 

o Current date and time, . . . 
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In a document, you can choose to have headers and footers: 

o The same on every page 

o Different for the first page of your document 

o Different on odd and even pages 

• Insert the same header or footer on each page 

MS Word includes many predesigned headers and footers that you can insert into your 

document. 

o Automatic page numbering 

Steps 

 On the Insert tab,  

 click the Page Number icon, and 

  Then click Page Number. 

  Select a location, and  

 Then pick an alignment style.  

 Word automatically numbers every page, except designated title pages. 

o Page Numbering 

Create header or footer that contains only page number: 

Steps 

 On the Insert tab 

 In Header and Footer group 

 Click Page number 

 Click Top of page or bottom of page depending on where you want a page 

number to appears in your document 

 Choose a page number design from the gallery of designs. 
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o Footnotes 

 Footnotes appear at the bottom of the page and endnotes come at the end of the 

document. A number or symbol on the footnote or endnote matches up with a 

reference mark in the document. 

How to Insert Footnotes in Word 2016 for Windows? 

Steps 

 Place the cursor in the text where the footnote mark should be located.  

 Click the References tab. 

 In the Footnotes group, choose Insert Footnote. ... 

 Type the footnote and add any formatting. 

Cited on https://helpx.adobe.com/acrobat/using/add-headers-footers-pdfs.html 

Cited on https://pdf.wondershare.com/how-to/add-header-footer-to-pdf.html 

Cited on : https://www.foxit.com/blog/how-to-add-headers-and-footers-to-pdfs 

 

 Activity 2: Guided Practice 

Task: 

With your trainer guidance you are going to add page numbers and  change format to see the 

output: 

a. Click on the Insert tab 

b. In Header and Footer group, click Page number 

c. Click Top of page or bottom of page depending on where you want a page number to 

appears in your document.  

Note: If you want you change format click format page number, if not leave as it is and 

click Top of page or bottom of page; Choose a page number design from the gallery of 

designs. 
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 Activity 3: Application 

Task:  

You work in a cybercafé, and a client comes to you, asking to print a document. However, 

the document does not have page numbers. The client requests you to add the page 

numbers at the bottom, and you notice that the pages will have two different page number 

formats: 

a. What will you do to add page number of different formats? 

b. Add the page number and explain you answer. 

 

 Formative Assessment  

2. Where do you see the number of pages you have in the file? 

a. Ribbon 

b. Status bar 

c. Title bar 

3. Microsoft Word is called a Word Processing Program 

a. True 

b. False 

4. Where do you see number of pages you have in the file? 

a. Ribbon 

b. Status bar 

c. Title bar 

5. Tools used to change color and font size and font style are located in ribbon under 

which tab? 

a. Font tab 

b. Status bar 
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c. Title bar 

d. All the above 

6. Which of the following are the most popular font style? 

a. Times New Roman 

b. Calibri 

c. Arial 

d. Verdana 

6. Which menu do you use to add table? 

b. File 

c. Insert 

d. Tool 

7. Under insert menu which bar do you find page number in? 

a. comments 

b. Header and footer 

c. Pages 

8.  Which of the following is required to add different headers or footers to different 

parts of a document? 

a.  Page breaks at the end of each page. 

b.  Section breaks, Next Page. 

c.  Alignment tabs 

9. You must highlight text before you can format  

a. True 

b. False 

10. A font is a style of writing 

a. True 

b. False 

11. A spelling checker program can detect spelling errors 

a. True 

b. False 

12. You cannot add pictures to a Microsoft Word document 

a. True 



69 
 

b. False 

13. You can control where you save a document by using the Save As command 

a. True 

b. False 

14. Right justified means that the right margin will be ragged 

a. True 

b. False 

15. Information is inserted where the cursor is blinking 

a. True 

b. False 

 

 Points to Remember 

● Always Apply formatting styles to you document 

● Find and replace makes it easy and quick to work on your document 

● Text alignment makes the document to be readable and smart 

● Remove unwanted formatting 

● Tell the program exactly what you want to do. 

● Always Paste Text without Formatting 

● Select the default font you want, not the default font Word wants you to use. 
Table 8:LU.2 Points to Remember 
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Self-Reflection: Learning unit 2 

Reflect on your achievement in the above learning Unit, base your reflection on activities 

done and your performance.  

My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Define a MS word      

Differentiate MS Word 

screen elements 

     

Explain different text 

formatting options 

     

Explain different paragraph 

formatting options 

     

Describe how you can 

create and edit table 

     

Describe how to edit a 

document 

     

Explain how to insert 

Footnotes, footers, and 

headers 
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My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Describe automatic page 

numbering   

     

Explain how to know the 

total number of pages 

     

Describe file management      

Create files and folders      

Name files and format 

them 

     

Describe page setup      

Explain the detailed printer 

options 

     

Printing one or more 

copies 

     

Table 9:Self-Reflection LU.2 
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Fill the table below to identify your areas of strength, areas for improvement 

and actions to take to improve. 

 

Areas of strength Areas for improvement Actions to be taken to 

improve 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 

Table 10:Strength and Area of Improvement LU.2 
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UNIT 3: USE OF CURRENT SPREADSHEET PACKAGE 

 
 

Figure 12: Illustration of Spreadsheets; https://www.noupe.com/business-online/best-online-spreadsheet-database-

software.html12 

 

Unit summary: 

A spreadsheet is a file that exists of cells in rows and columns and can help arrange, 

calculate and sort data. Data in a spreadsheet can be numeric values, as well as text, 

formulas, references and functions. 

  

                                                             
12 Cited by https://www.noupe.com/business-online/best-online-spreadsheet-database-software.html 
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Self-Assessment: Unit 3 

1. Look at the illustration. What is happening? What do you think this learning outcome 

will be about?  

2. Fill in the self-assessment below.  

There are no right or wrong ways to answer this survey.  It is for your own use during 

this course.  Think about yourself:  do you think you can do this? How well?  Read the 

statements across the top. Put a check in column that best represents your 

situation.  At the end of this learning outcome, we’ll take this survey again.  

My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a lot 

of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Open and Close excel      

Select a sheet       

Rename a sheet and 

insert new sheets  

     

Move a sheet in a 

workbook  

     

Format text and cells       

Choose font, size, color      

Adjust cow height      

Align a cell, rotate a text, 

and wrap text and 

number format 

     

Merge a cell      

Create borders      

Create Patterns      

Insert rows      
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My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a lot 

of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Describe Numbers and 

mathematical operations 

     

Describe Logical function 

(IF) 

     

Explain Page setup      

Print preview      

Print dialogue box      

Print one or more copies      

Print page ranges, 

printing selection, Print 

current worksheet 

     

Table 11:LU.3 Self-Assessment  

Key Competencies of Learning Unit 3: 

Knowledge Skills Attitudes 

1. Describe and 

demonstrate of Basic 

Excel tasks 

1. Know the basic excel 

tasks 

v Be respectful and know 

the basic skills of excel 

2. Manage sheets in 

Excel workbook 

2. Create a workbook v Understand and create 

a workbook 

3. Explain renaming a 

sheet and inserting 

new sheets 

3. Rename and insert 

sheets 

v Apply carefully cell 

renaming and insertion 
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4. Describe how to 

format cells and their 

contents 

4. Format cells and 

contents 

v Attentively format the 

cells and content 

5. Describe alignment of 

cell, rotating text, 

wrapping text and 

number format 

5. Apply alignment of 

cell, rotating text, 

wrapping text and 

number format 

v Apply text changes 

carefully 

6. Identify how to use 

some functions and 

perform 

mathematical 

operations 

6. Apply functions and 

mathematical 

operations to the 

workbook 

v Respectively apply 

mathematical functions 

7. Identify how to use 

Logical function (IF) 

7. Use Logical functions v Apply logical functions  

8. Describe the printing 

option of an Excel 

worksheet 

8. Printing 0ptions of a 

worksheet 

v Carefully print a 

worksheet 

9. Describe the printing 

preview, page setup, 

page ranges, printing 

selection, Print 

current worksheet 

9. Check the page setup, 

page ranges, printing 

selection, Print current 

worksheet 

v Print the pages carefully 

Table 12:LU.3 Key Competences 
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 Discovery activity 

 

Task: 

The above sheet is very useful for storing, organizing, and analyzing data. In business, any 

function in any industry can benefit from individuals with strong knowledge in using it. In your 

observation, you may have noticed this as well,  

a. What is the scientific name given to the sheet above 

b. Where can we find the above sheet in the computer 

c. Can anyone use it or it needs extra skills 

d. Study the illustration well and note down what you see  
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Topic 3.1: Using Basic Excel Tasks 

 Activity 1: Problem Solving 

Task: 

Using an appropriate methodology such as individual work, in pairs, or in small groups, 

trainees conduct research in the school library or computer lab. You are writing an Excel 

document, and you want to perform mathematical functions in your document. You have 

added all the records needed, but there are some columns that need to be joined:  

a. What is the common word used when joining two or more columns or rows? 

b. What does formula bar used for in excel? 

 

Key Facts 3.1 

• Basic Excel tasks 

o Open and Close excel 

Type "excel" in the search box right to Windows start button. Click "Excel" from search 

results. 
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o Close Excel application 

Click the close application button on extreme top right corner to close and 

quit the Excel application, as shown below. 

  
Excel will prompt you with a dialog box to save any unsaved changes in your Excel 

Workbook, as shown below. 

 
Alternatively, you may press "Alt" + "F4" keys together to close any active window 

o Save your workbook 

Steps 

 Click File > Save As. 

 Under Save As, pick the place where you want to save your workbook. 

 Click Browse to find the location you want in your Documents folder. 

 In the File name box, enter a name for a new workbook. 

 To save your workbook in a different file format 

 Click Save. 

 

o Create a workbook 

o Open a Workbook and Entering data  

To open an existing workbook: 
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steps: 

 Open a Workbook and Entering data 

 To open an existing workbook: 

 Click the Microsoft Office Button 

 Click Open 

 Browse to the workbook 

 Click the title of the workbook 

 Click Open 

 

o To enter data in an active cell: 

 Click in the cell where you want the data 

 Begin typing 

o To enter data into the formula bar 

 Click the cell where you would like the data 

 Place the cursor in the Formula Bar 

 Type in the data 

Excel allows you to move, copy, and paste cells and cell content through cutting and pasting and 

copying and pasting. 

o Select Data 

 To select a cell or data to be copied or cut: 

 Click the cell 

 Click and drag the cursor to select many cells in a range 

 Select a Row or Column to select a row or column 

 click on the row or column header. 

o To copy and paste data: 

 Select the cell(s) that you wish to copy 

 On the Clipboard group of the home tab, 

 click Copy 

 Select the cell(s) where you would like to 

 copy the data 

 On the Clipboard group of the home tab, 



81 
 

o Paste Cut and Paste 

 

 Select the cell(s) that you wish to copy 

 On the Clipboard group of the home tab, click Cut 

 Select the cell(s) where you would like to copy the data 

 On the Clipboard group of the home tab, 

o Paste Undo and Redo 

 On the Quick Access Toolbar 

 Click Undo or Redo 

 
 The Auto Fill feature fills cell data or series of data in a worksheet into a 

selected range of cells. If you want the same data copied into the other 

cells, you only need to complete one cell. If you want to have a series of 

data (for example, days of the week) fill in the first two cells in the series 

and then use the auto fill feature. To use the Auto Fill feature: 

 Click the Fill Handle 

 Drag the Fill Handle to complete the cells 

 

o Insert Cells, Rows, and Columns in Excel: 

 

  Place the cursor in the row below where you want the new row, 

or in the column to the left of where you want the new column 

 Click the Insert button on the Cells group of the home tab 

 Click the appropriate choice: Cell, Row, or Column 

Column Delete Cells, Rows and Columns 

 Place the cursor in the cell, row, or column that you want to delete 
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 Click the Delete button on the Cells group of the Home tab 

 Click the appropriate choice: Cell, Row, or Column of delete row and 

column and duplicate cell 

Step 2: 

• Select the data range. 

• Then click Data > Data Tools 

•  Remove Duplicates. 

• A dialog box will open up. 
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Step 3:  

➤ Mark the columns and press OK 

The 

duplicate rows will be removed and a notification box will pop up the message. 
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o Basic Excel tasks 

 

o Open and Close excel 

Type "excel" in the search box right to Windows start button. Click "Excel" from search 

results. 

 

• Close Excel application 

• Click the close application button on extreme top right corner to close and quit 

the Excel application, as shown below. 

  
Excel will prompt you with a dialog box to save any unsaved changes in your Excel 

Workbook, as shown below. 

 

 
Alternatively, you may press "Alt" + "F4" keys together to close any active window 
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o Save your workbook 

Steps 

 Click File > Save As. 

 Under Save As, pick the place where you want to save your workbook. 

 Click Browse to find the location you want in your Documents folder. 

 In the File name box, enter a name for a new workbook. 

 To save your workbook in a different file format 

 Click Save. 

 

o Create a workbook 

o Open a Workbook and Entering data  

To open an existing workbook: 

 

steps: 

 Open a Workbook and Entering data 

 To open an existing workbook: 

 Click the Microsoft Office Button 

 Click Open 

 Browse to the workbook 

 Click the title of the workbook 

 Click Open 

 

To enter data in an active cell: 

 Click in the cell where you want the data 

 Begin typing 

To enter data into the formula bar 

 Click the cell where you would like the data 

 Place the cursor in the Formula Bar 

o Type in the data 

Excel allows you to move, copy, and paste cells and cell content through cutting and 

pasting and copying and pasting. 
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o Select Data 

 To select a cell or data to be copied or cut: 

 Click the cell 

 Click and drag the cursor to select many cells in a range 

 Select a Row or Column to select a row or column 

 click on the row or column header. 

o To copy and paste data: 

 Select the cell(s) that you wish to copy 

 On the Clipboard group of the home tab, 

 click Copy 

 Select the cell(s) where you would like to 

 copy the data 

 On the Clipboard group of the home tab, 

click Paste Cut and Paste 

 Select the cell(s) that you wish to copy 

 On the Clipboard group of the home tab, click Cut 

 Select the cell(s) where you would like to copy the data 

 On the Clipboard group of the home tab, 

click Paste Undo and Redo 

 On the Quick Access Toolbar 

 Click Undo or Redo 

 
 The Auto Fill feature fills cell data or series of data in a worksheet into a 

selected range of cells. If you want the same data copied into the other 

cells, you only need to complete one cell. If you want to have a series of 

data (for example, days of the week) fill in the first two cells in the 

series and then use the auto fill feature. To use the Auto Fill feature: 

 Click the Fill Handle 
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 Drag the Fill Handle to complete the cells 

o Insert Cells, Rows, and Columns in Excel: 

 

 Place the cursor in the row below where you want the new row, or in 

the column to the left of where you want the new column 

• Click the Insert button on the Cells group of the home tab 

 

 Click the appropriate choice: Cell, Row, or Column 

Column Delete Cells, Rows and Columns 

 Place the cursor in the cell, row, or column that you want to delete 

 

 Click the Delete button on the Cells group of the home tab 

 

 Click the appropriate choice: Cell, Row, or Colum of delete row and 

column and duplicate cell 

Step 2: 

 Select the data range. 

 Then click Data > Data Tools 

  Remove Duplicates. 

 A dialog box will open up. 
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Step 3:  

 Mark the columns and press OK 

 

The duplicate rows will be removed and a notification box will pop up the message. 



89 
 

 

https://www.gacbe.ac.in/pdf/ematerial/18BCS5EL-U5.pdf 

https://ccsuniversity.ac.in/bridgelibrary/pdf/DHA_Shikha_BHI_204_Unit4.pdf13 

 Activity 2: Guided Practice 

Task:  

You are a manager in a liquor store, and you have to design an Excel sheet that you will be 

using daily. The sheet should allow you to add new liquors to your list when you bring in new 

stock and remove liquors from the list when they are finished or out of stock. Design that 

excels sheet 

a. How can you add cells, rows or columns in Excel? 

b. Write down the steps deleting the whole table and merging the cell 

  

                                                             
13 https://www.gacbe.ac.in/pdf/ematerial/18BCS5EL-U5.pdf 
https://ccsuniversity.ac.in/bridgelibrary/pdf/DHA_Shikha_BHI_204_Unit4.pdf 



90 
 

 Activity 3: Application 

Task:  

Your supervisor has given you the task of managing the inventory in the supermarket and 

creating a good spreadsheet to show him all the products that have expired, those that 

are near expiring (remaining with 20 days), and the fresh products for the entire 

December 2022; 

a. How many columns will you insert? 

b. How many rows will you use? 

c. In case the supervisor remembers a product which you had forgotten list the steps 

you will follow to add it 

d. He may also ask you to combine two products name the steps for merging cells 

How can you add value from two cells using the sum function? 
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Topic 3.2:  Management of Sheets in Excel Workbook 

 Activity 1: Problem Solving 

Task: 

You are requested to answer the following; 

a. What is the syntax on add number from the range of cells? 

b. Which function you can use to calculate the average on the numbers 

 

Key Facts 3.2 

• Selecting a sheet 

 

Selecting a cell in Excel is the first step in entering data or executing most commands in 

a worksheet. The single cell that receives the data. When a cell is selected, its border 

becomes bold and the column and row indicators are highlighted. Click the tab for the 

sheet you want to edit. The active sheet will be a different color than other sheets. In 

this case, Sheet4 has been selected 

 

 
If you don't see the tab that you want, click the scrolling buttons to locate the tab. You 

can add a sheet by pressing the Add Sheet button to the right of the sheet tabs. 

 

o Renaming a sheet and inserting new sheets 

To rename a worksheet: 

 Double-click the sheet tab, and type the new name. 
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 Right-click the sheet tab, click Rename, and type the new name. 

 Use the keyboard shortcut Alt+ H > O > R, and type the new name. 

 

o Moving a sheet in workbook 

You can move or copy a worksheet in the same workbook to organize your workbook 

exactly how you want. 

 Select the worksheet tab,  

 and drag it to where you want it 

o Insert a worksheet 

 Select the plus icon at the bottom of the screen. 

 Or, select Home > Insert > Insert Sheet. 

 
o Delete a worksheet 

 Right-click the Sheet tab  

 and select Delete. 

 Or, select the sheet, and then select Home > Delete > Delete Sheet. 

 Select OK 

 
https://adminfinance.umw.edu/tess/files/2013/06/Excel-Manual1.pdf 
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 Activity 2: Guided Practice 

Task:  

Think of giving HR assistance in making payments for employees. With your trainer's 

guidance, perform the following steps: 

1. Create a new workbook as shown below. 

2. Save the file with the name “Payroll”.  

a. Enter the labels and values in the exact cells locations as desired.   

b. Use AutoFill to put the Employee Numbers into cells A6:A8.  

a. Set the columns width and rows height appropriately. 

b. Set labels alignment appropriately.  

c.  Use warp text and merge cells as desired.  

d. Apply borders, gridlines and shading to the table as desired 

 Activity 3: Application 

Task: 

Read the scenario and perform the following task: A teacher creates a table and names it 

'marks.' Then, he requests you to add the marks into the Excel sheet due to the fact that 

you're under his supervision as an intern. Which formulas will you use to get the total and the 

average of the marks accordingly? 

a. Write down the steps to calculate the total of mark? 

b. Write down all the steps to calculate the average of numbers? 
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Topic 3.3:  Formatting Cells and their Contents 

 Activity 1: Problem Solving 

Task: 

You are requested to select cells, ranges, rows, or columns. Range: Two or more cells on a 

sheet. Cell ranges are identified by the first cell address in the range then the colon followed 

by the last cell address e.g. A1:A5, D3, H8:H10. 

a. What can you do to add in D3 summation of range A1:A5? 

b. How can you format cell H8:H10 in Date format?  Explain the all process. 

 

Key Facts 3.3 

• Formatting text and cells 

Formatting text or numbers can make them appear more visible. Changing default 

formats includes things like changing the font color, style, size, text alignment in a cell, 

or apply formatting effects.  

 

o Select the cell or cells that will have the formatting 

o Click the Dialog Box arrow on the Alignment group of the home tab  

There are several tabs on this dialog box that allow you to modify properties of the cell 

or cells. 

 Number: Allows for the display of different number types and decimal 

places 

 Alignment: Allows for the horizontal and vertical alignment of text, 

wrap text, shrink text, merge cells and the direction of the text.  

 Font: Allows for control of font, font style, size, color, and additional 

feature 

 Border: Border styles and colors 

 Fill: Cell fill colors and styles 
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o Add Borders and Colors to Cells 

To add borders manually 

 Click the Borders drop down menu on the Font group of the home tab 

 Choose the appropriate border 

To apply colors manually 

 Click the Fill drop down menu on the Font group of the home tab 

 Choose the appropriate color 

 

To apply borders and colors using styles 

 

 Click Cell Styles on the Home tab 

 Choose a style or click New Cell Style 

 Change Column Width and Row Height 

 Click the Format button on the Cells group of the home tab 

 Manually adjust the height and width by clicking Row Height or Column 

Width 

 To use AutoFit, click AutoFit Row Height or AutoFit Column Width Hide  

 

Unhide Rows or Columns 

 To hide or unhide rows or columns: 

 Select the row or column you wish to hide or unhide 

 Click the Format button on the Cells group of the home tab 

 Click Hide & Unhide 

o Merge Cells 

To merge cells, select the cells you want to merge and click the Merge & Center button 

on the Alignment group of the home tab. 

o Merge & Center: Combines the cells and centers the contents in the new, larger 

cell  

o Merge Across: Combines the cells across columns without centering data 

o Merge Cells: Combines the cells in a range without centering 

o Unmerge Cells: Splits the cell that has been merged 
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o Align Cell Contents 

 

To align cell contents, click the cell or cells you want to align and click on the options 

within the Alignment group on the home tab. 

o Top Align: Aligns text to the top of the cell 

o Middle Align: Aligns text between the top and bottom of the cell 

o Bottom Align: Aligns text to the bottom of the cell  

o Align Text Left: Aligns text to the left of the cell  

o Center: Centers the text from left to right in the cell 

o  Align Text Right: Aligns text to the right of the cell 

o Decrease Indent: Decreases the indent between the left border and the text 

o Increase Indent: Increase the indent between the left border and the text 

o Orientation: Rotate the text diagonally or vertically 

https://uomustansiriyah.edu.iq/media/lectures/3/3_2020_11_18!10_20_17_AM.pdf  
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 Activity 2: Guided Practice 

 

 

Figure 13:excel exercise; https://www.sgul.ac.uk/about/our-professional-services/information-

services/library/documents/training-manuals/Excel-Fundamentals-Manual.pdf14 

 

Task:  

1. Type the labels: these are the titles of each column of data. Use the tab or arrow keys to 

navigate quickly to the next cell. (Hint: you can use the autofill feature to quickly fill in the 

labels that are the months) 

2. Next, type the names listed in column A. Remember to resize the column if the name is 

longer than the cell.  

3. Type the constants: these are the monetary values you see above. Use the number 

formatting command to format the cells to “currency”. 

4. Ask constantly the assistance for your trainer where necessary   

                                                             
14 ; https://www.sgul.ac.uk/about/our-professional-services/information-services/library/documents/training-
manuals/Excel-Fundamentals-Manual.pdf 
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 Activity 3: Application  

Task: 1  

 

Add two numbers Steps:  

1. Open a spreadsheet and type in the labels called number 1 and number 2 in the cells A1 

and B1 and add in the cell C1. This is just for us to identify the values and they are not 

involved in actual execution  

2. In A2 and B2, type in the numbers to be added.  

3. In C2, type in =A2+B2 and press enter to display the result. In excel calculations are 

prefixed with = sign followed by the operation on cells 

4. The cell number represents the numbers (For e.g. A2 and B2 are used which denote 3 and 

5 respectively with a plus sign in between as in the case of normal addition. 

5. To add more than two numbers, add as many columns (number1, number2, number3 etc., 

and extend the formula as =A2+B2+C2+….  
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Topic 3.4: Using Functions and Perform Mathematical Operations 

 Activity 1: Problem Solving 

Task: 

1. Imagine you are a financial manager at a certain construction site where you are required 

to be paying the workers every evening from those heading the site to the last minor 

helper and your required to make their everyday payments to show your manager, with 

the help of the computer which Microsoft tool will use. 

2. Assuming cell A1 is displaying the number "12000.7789". What formula should be used to 

round this number to the closest integer? 

3. Which of the following is the correct formula to calculate the weighted average score in 

cell C8 as shown below? 

 

a. =SUMPRODUCT (C2:C5, B2:B5) 

b. =SUMPRODUCT (C2:C4, B2:B4) 

c. =AVERAGE (B2:B4) 

d. =AVERAGE (C2:C4) 
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Key Facts 3.4 

• Numbers and mathematical operations 

A formula is a set of mathematical instructions that can be used in Excel to 

perform calculations. Formals are started in the formula box with an = sign. 

 
 

There are many elements to and excel formula. 

o References: The cell or range of cells that you want to use in your calculation 

o Operators: Symbols (+, -, *, /, etc.) that specify the calculation to be performed 

o Constants: Numbers or text values that do not change 

o Functions: Predefined formulas in Excel 

o Select the cell for the formula 

o Type = (the equal sign) and the formula 

o Click Enter 

SUM 

The first Excel function you should be familiar with is the one that performs 

the basic arithmetic operation of addition: 

o SUM (number1, [number2], …) 

In the syntax of all Excel functions, an argument enclosed in [square 

brackets] is optional, other arguments are required. Meaning, your Sum 

formula should include at least 1 number, reference to a cell or a range of 

cells. For example: 

 =SUM (A2:A6) - adds up values in cells A2 through A6. 

 =SUM (A2, A6) - adds up values in cells A2 and A6. 
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 =SUM (A2:A6)/5 - adds up values in cells A2 through A6, and 

then divides the sum by 5. 

o AutoSum 

Select a cell next to the numbers you want to sum, click AutoSum on the Home tab, 

press Enter, and you're done. When you click AutoSum, Excel   automatically enters   a   

formula (that   uses the SUM function) to sum the numbers. 

Subtraction 

o Type a number in cells C1 and D1. 

For example, a 5 and a 3. 

o In cell E1, type an equal sign (=) to start the formula. 

o After the equal sign, type C1-D1. 

o Press Return 

 

If you used the example numbers, the result is 2. 

 

Multiplication 

You can also multiply two different cells together. 

o In a cell, type "=" 

o Click in the cell that contains the first number you want to multiply. 

o Type "*". 

o Click the second cell you want to multiply. 

o Press Enter. 

AVERAGE 

The Excel AVERAGE function does exactly what its name suggests, i.e. finds an average, 

or arithmetic mean, of numbers. Its syntax is similar to SUM's: 

o AVERAGE (number1, [number2], …) 

o instead of typing =SUM (A2:A6)/5, you can simply put =AVERAGE (A2:A6)  

MAX & MIN 

o =MAX (A2:A6) 
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o =MIN (A2:A6)  

 

COUNT & COUNTA 

o If you are curious to know how many cells in a given range contain numeric 

values (numbers or dates), don't waste your time counting them by hand. The 

Excel COUNT function will bring you the count in a heartbeat: 

o COUNT (value1, [value2], …) 

o While the COUNT function deals only with those cells that contain numbers, the 

Excel COUNTA function counts all cells that are not blank, whether they contain 

numbers, dates, times, text, logical values of TRUE and FALSE, errors or empty 

text strings (""): 

COUNTA (value1, [value2], …) 

For example, to find out how many cells in column A contain numbers, use this formula: 

o =COUNT (A: A) 

To count all non-empty cells in column A, go with this one: 

o =COUNTA (A: A) 

In both formulas, you use the so-called "whole column reference" (A:A) that refers to all 

of the cells within column A. 

Logical function (IF) 

Judging by the number of IF-related comments on our blog, it's the most popular 

function in Excel. 

In simple terms, you use an IF formula to ask Excel to test a certain condition and return 

one value or perform one calculation if the condition is met, and another value or 

calculation if the condition is not met: 

o IF(logical _test, [value _if true], [value _if false]) 

 For example, the following IF statement instructs Excel to check the value in A2 and 

return "OK" if it's greater than or equal to 3, "Not OK" if it's less than 3: 

o =IF(A2>=3, "OK", "Not OK") 

RANK 

o If you give the RANK function a number, and a list of numbers, it will tell you the 

rank of that number in the list, either in ascending or descending order. 
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o For example, in the screen shot below, there is a list of 10 student test scores, in 

cells B2:B11. 

o To find the rank of the first student's score in cell B2, enter this formula in cell 

C2: 

=RANK (B2, $B$2: $B$11) 

https://uomustansiriyah.edu.iq/media/lectures/6/6_2020_07_12!01_47_47_PM.pdf 

https://or6my.quantummach.biz/mathematical-operations-pdf 

 Activity 2: Guided Practice 

Task;  

1. You're helping the financial office in a certain newly opened car shop, and you need to 

pay the employees. First, you have to know the gross salary of each employee. After that, 

you calculate the net salary for each employee. To complete the task, follow all these 

steps below, and then come up with this Excel sheet 

 
a. Open the workbook called PE Formulas and Functions.xlsx (it can be found in the 

same folder as the student files)  
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b. Create a formula that calculates the gross pay for each employee, then use a 

function to calculate the total of the gross pay ‘The total for Gross Pay should 

appear in E14’  

c. Create a formula that calculates the tax as being 20% of the gross pay for each 

employee, then create a total for the tax  

d. Create a formula to calculate the net pay for each employee and then a total of the 

net pay 

e. Create a formula that calculates the superannuation as being 8% of the gross pay 

for each employee, then create a total for superannuation  

f.  Use functions to determine the average, maximum and minimum values for each 

column, setting the number of decimal places to 2 Your worksheet should appear 

as shown on the following page...  

g. Use the Save As command to save the workbook as PE Formulas and Functions 

(Completed).xlsx 

 Activity 3: Application 

Task:  

Put yourself in the position of an advisor to the financial ministry of Rwanda, as the year 

of budgeting has approached. In your capacity, create a well-structured budget for the 

following organizations: schools, agriculture sector, health sector, and the local 

government. Please remember that you will present the budget to the cabinet, so ensure 

to do a good job. Work in a group of three trainers and consider that each mentioned 

sector will have a different budget  
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Topic 3.5: Saving and Printing an Excel worksheet 

 Activity 1: Problem Solving 

Task:  

Most users experience printing problems in Excel. Suppose you are given an Excel sheet for 

printing, and you notice that columns are cut from the spreadsheet, or it may print half of the 

content on one sheet and another half on another sheet. There may also be an improper 

layout orientation due to which the full data is not on a single sheet. Likewise, there occur 

different printing problems which can be frustrating for a user.  

a. How easily can the above be solved?  

b. What different modifications can you apply to print something better 

c. List some of excel settings before printing the excel spreadsheets 

Key Facts 3.5 

Saving an Excel Sheet 

When you have multiple worksheets in an Excel workbook, you might want 

to save only one worksheet as its own workbook. Use the Move or Copy 

function to save one worksheet in Excel 2013 or Excel 2016. 

Save a single worksheet 

Right-click the worksheet name tab. 

 
Click select Move or Copy. 
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Click on the Move selected sheets to Book drop-down menu. Select (new 

book). 

 

Click OK. Your new workbook opens with your moved worksheet. 

Note: This process moves your worksheet from the original workbook. If 

you want to keep your worksheet in both workbooks, in the Move or 

Copy dialog box, select the check box for Create a copy. 

 

Click File > Save in your new workbook. 

Tip: You can also save your Excel workbook with the keyboard shortcut, 

Ctrl + S. 
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Printing an Excel worksheet 

In Excel, there are many things you can do to prepare your workbook for 

printing. Many of these tasks make it easier to format the spreadsheet for 

the printed page. In this lesson, you will learn how to view the spreadsheet 

in Print Preview, modify margins, change the page orientation, use the 

Scale to Fit feature, use the Print Titles command, and insert breaks. 

To view the spreadsheet in Print Preview: 

Left-click the Microsoft Office button. 

Select Print. 

Select Print Preview. The spreadsheet will appear in Print Preview view. 

 
 

Click the Close Print Preview button to return to the Normal View. To make 

previewing your spreadsheet easier, add the Print Preview command to 

the Quick Access toolbar. 

Exploring Print Preview 

Once you are in Print Preview, you can access many of the same features 

that you can access from the Ribbon; however, in Print Preview you can 

see how the spreadsheet will appear in printed format. 
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To modify margins, column width, or row height while in Print Preview: 

Click the Print Preview command on the Quick Access toolbar, or select 

Print Preview from the Microsoft Office button menu. The spreadsheet 

opens in Print Preview mode. 

Hover your cursor over one of the black margin markers until a double 

arrow appears. 

 
Left-click and drag the marker to the desired location. The change will be 

reflected in the spreadsheet. To modify margins: 

Select the Page Layout tab. 

Left-click the Margins command. 

Choose one of the pre-defined settings, or enter custom margins 
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To change page orientation: 

Select the Page Layout tab. 

Left-click the Orientation command. 

Select either Portrait or Landscape 

 

Portrait orients the page vertically, while Landscape orients the page 

horizontally. To use Scale to Fit: 

Select the Page Layout tab. 

Locate the Scale to Fit group. 

Enter a specific height and width, or use the percentage field to decrease 

the spreadsheet by a specific percent. 

Scale to Fit is a useful feature that can help you format spreadsheets to fit 

on a page. However, be careful with how small you scale the information—

it can become difficult to read! 

To change the paper size: 

Select the Page Layout tab. 
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Click the Size command. 

Select a size option from the list. 

To define a print area: 

Left-click, then drag your mouse to select the cells you wish to print. 

Click the Print Area command. 

Choose Set Print Area. 

 
 

Now, only the selected cells will print. You can confirm this by viewing the 

spreadsheet in Print Preview. To return to the default setting, which is the 

entire worksheet, click the Print Area command, then select Clear Print 

Area. 

 

To insert a break: 

Select a cell below where you want the break to appear 

Select the Breaks command. 

Select Insert Break. 

Click Print Preview to confirm that the break appears in the correct place 

in your spreadsheet. 

To use the Print Titles command:  

This is an important command to be familiar with if you intend to print your 

worksheets. It allows you to select specific rows and/or columns that will 

be repeated on each printed sheet. Imagine how difficult it would be to 

read page 48 of a printed spreadsheet if the column and row headings only 

appeared on the first page. 

Select the Page Layout tab. 

Click the Print Titles command. The Page Setup dialog box appears. 
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Click the icon at the end of the field. 

Select the first row in the spreadsheet that you want to appear on each 

printed page. 

 

Repeat for the column, if necessary. 

Click OK. 

To print from the Microsoft Office button: 

Left-click the Microsoft Office button. 

Select Print. The Print dialog box appears. 

 
Select a printer if you wish to use a printer other than the default setting. 

Click Properties to change any necessary settings. 

Choose whether you want to print specific pages, all of the worksheet, a 

selected area, the active sheet, or the entire workbook. 

Select the number of copies you'd like to print. 

Click OK. 

You can select Quick Print to bypass the Print dialog box. 

https://www.novapdf.com/printing-an-entire-excel-workbook-to-a-single-pdf-file-kb.html 
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 Activity 2: Guided Practice 

Task: 

 
a. With the guidance of the trainer, from above figure fill the role of indicated feature in 

table below   

Number Role /Descriptions 

1  

2  

3  

4  

5  

6  

7  
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 Activity 3: Application 

Task: You are a final year student who has recently completed an internship in a 

certain company or organization, and you are requested to print your IAP REPORT in the 

format provided by the school. How can you do it? 

a. Print your document on the same pages back and Infront 

b. Print that document looks well with page numbers indicated 

c. Print the document in a recognized colour 

d. Make sure that pictures can be seen well 

 

Formative Assessment  

Choose the correct answer:  

1. The files that are created with Spreadsheet software are called 

a. Package 

b. Program 

c. Worksheet 

2. Which is used to calculate and analyze a set of numbers? 

a. Improve 

b. StarCalc 

c. Spreadsheet 

d. Database 

3. Spreadsheet, sometimes is called as 

a. Cells 

b. Worksheet 

c. Menus 

d. Notebook pages 

4. Which bars have shortcut icons for frequently done tasks in the Spreadsheet? 
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a. Main Tool bar 

b. Object bar 

c. Formula bar 

d. Menu bar 

5. The Spreadsheet VisiCalc contains 

a. 63 columns and 254 rows 

b. 256 rows and 256 columns 

c. 10000 rows and 256 columns 

d. 36000 rows and 256 columns 

6. Which shortcut icon is used to select and insert functions? 

a. Functional Auto pilot 

b. File series 

c. Function wizard 

d. Category 

7. The cells are addressed in terms of 

a. Row and column labels 

b. Row labels 

c. Rows 

d. Columns 

8. Which of the following data can be typed into a Spreadsheet cell? 

a. Formulae 

b. Text 

c. Numbers 

d. All of these 

9. Which bar is used to display options? 

a. Menu 

b. Function 

c. Formula 

d. Status 

10. The intersection of rows and columns creates 

a. Cells 

b. Worksheets 
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c. Spreadsheets 

d. None of these 

11. The intersection of rows and columns creates 

a. Cells 
b. Worksheets 

c. Spreadsheets 

d. None of these 

12. Worksheet data can be viewed in forms of 

a. Charts 

b. Graphs 

c. Charts or graphs 

d. Data 

13. By pressing ____ key and type in the range you want, the suggested range will be 

accepted. 

a. Backspace 

b. Open 

c. Close 

d. Enter 

14. Address of first cell in the worksheet is 

a. A 

b. A0 

c. A1 

d. 1A 

15. What computer program lets we use an electronic ledger sheet for financial analysis? 

a. Worksheet program 

b. Word processors 

c. Spreadsheet program 

d. Menu driven program 
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 Points to Remember: Learning Unit 3 

• Use Pivot tables to recognize and make sense of data. 

• Add more than one row or column. 

• Use filters to simplify your data. 

• Remove duplicate data points or sets. 

• Transpose rows into columns. 

• Use Pivot tables to recognize and make sense of data. 

Always remember to save your excel sheet 

Table 13: LU.3 Points to Remember 

Self-Reflection: Learning unit 3 

Reflect on your achievement in the above learning Unit, base your 

reflection on activities done and your performance.  

My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experienc

e with 

this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Open and Close excel      

Select a sheet       

Rename a sheet and 

insert new sheets  

     

Move a sheet in a 

workbook  

     

Format text and cells       

Choose font, size, color      
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My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experienc

e with 

this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Adjust cow height      

Align a cell, rotate a text, 

and wrap text and 

number format 

     

Merge a cell      

Create borders      

Create Patterns      

Insert rows      

Describe Numbers and 

mathematical operations 

     

Describe Logical function 

(IF) 

     

Explain Page setup      

Print options      

Print preview      

Print dialogue box      

Print one or more copies      

Print in black/white or 

color 
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My experience I don’t 

have any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have 

some 

experience 

doing this.   

I have a 

lot of 

experienc

e with 

this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Print page ranges, 

printing selection, Print 

current worksheet 

     

Fill the table below to identify your areas of strength, areas for improvement 

and actions to take to improve. 

 

Areas of strength Areas for improvement Actions to be taken to 

Improve 

1. 

2. 

3. 

1. 

2. 

3. 

1. 

2. 

3. 
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UNIT 4: USING CURRENT POWER POINT PRESENTATIONS 

 

 

 

 

 

 

 

 

 

 

Figure 14:PowerPoint illustration 

 

  

Unit summary: 

This unit describes how to create a new presentation in PowerPoint application Managing 

of a slide, graphics insertion in PowerPoint, will describe conversion of word documents to 

PowerPoint presentation, describing the animation of a presentation document, explaining 

the use of different presentation view, and describing Printing a presentation document 
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 Self-Assessment: Unit 4 

Study the Figure 1: look, observe carefully and answer the following questions  

a. What do you see in the figure? 

b. How does the figure relate to the unit? 

c. Do you think the figure reflects the learning unit? Explain your answer briefly 

d. What can be improved in the figure so that it reflects the unit? 

e. What do you think will be topics to be covered under this unit based on the 

figure? 

2. Fill in the self-assessment below.  

There are no right or wrong ways to answer this survey.  It is for your own use during this 

course.  Think about yourself:  do you think you can do this? How well?  Read the statements 

across the top. Put a check in column that best represents your situation.  At the end of this 

learning outcome, we’ll take this survey again.  

My experience I don’t have any 

experience 

doing this. 

I know a 

little about 

this. 

I have some 

Experience 

doing this 

I have a lot of 

experience with 

this 
Knowledge, skills 

and attitudes 

Create new 

presentation  

  .  

Explain the Blank 

presentation and 

Design template  

    

Create a slide     

Insert a slide      

Modify a slide     

Describe a Clip Art 

and a Word Art 
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My experience I don’t have any 

experience 

doing this. 

I know a 

little about 

this. 

I have some 

Experience 

doing this 

I have a lot of 

experience with 

this 
Knowledge, skills 

and attitudes 

Describe Library 

Images 

    

Insert image from 

file 

    

Describe Copy, cut, 

move  

    

Describe Import file      

Explain Process of 

conversion  

    

Describe Animation      

Explain Custom 

animation  

    

Describe Slide 

transition 

    

Describe Normal 

view  

    

Explain Slide sorter 

view  

    

Explain Slide show     

Describe Print 

preview  
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My experience I don’t have any 

experience 

doing this. 

I know a 

little about 

this. 

I have some 

Experience 

doing this 

I have a lot of 

experience with 

this 
Knowledge, skills 

and attitudes 

Print a copy or 

multiple copies  

    

Print one slide on a 

page  

    

Print more slides on 

a page 
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Key Competences: Learning Unit 4 

Knowledge Skills Attitudes 

1. Create a new 

presentation 

1. Identify a new 

presentation 

v Carefully understand a 

new presentation 

2. Manage of a slide 2. Describe the 

procedures to 

manage a slide 

v Follow carefully the 

procedures for slide 

management 

3. Insert of graphics 3. Apply graphics into 

a presentation 

v Patiently apply graphics 

4. Convert word 

documents to 

PowerPoint 

presentation 

4. Know converting 

word documents 

to PowerPoint 

presentation 

v Carefully convert words 

to ppt presentations 

5. Animate a presentation 

document 

5. Apply animation to 

presentation 

document 

v Attentively apply 

animations 

6. Use of different 

presentation view 

6. Identify different 

presentation view 

v Understand carefully 

presentation views 

7. Print a presentation 

document 

7. Manage document 

printing 

v Follow procedures of 

managing printing 

documents 

Table 14:LU.4 Key Competences 

  Discovery activity 

 



124 
 

Task:1.   

Turn to each other discuss on the picture above then answer the questions below 

a. What do you think the illustration above present? 

b. Where can the illustration above be used and who use the? 

c. Where can we find the illustration above in our computers 

d. What can it be used for? 

e. Note down all your answers 
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Topic 4.1 Creation of a new Presentation 

 Activity 1: Problem Solving 

 Task: 

A European tourist needs to take a trip for holidays in Africa for a month, which has to be 

funded by the company he is working with. The company leader requests him to prepare a 

good overview of what he requires for the trip and the countries he will visit. All this 

information needs to be presented to the entire team. In your respective groups, think about 

the scenario above and answer the following questions;  

a.  what will the tourist use to draft a convincing budget to the company manager and 

fellow employees?  

b. What steps can he use to design a good smart presentation 
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Key Facts 4.1    

Creation a new presentation 

 

o Definition of power point 

PowerPoint is a presentation program developed by Microsoft. PowerPoint is often used to 

create business presentations, but can also be used for educational or informal purposes. ... 

The presentations are comprised of slides, which may contain text, images, and other 

media, such as audio clips and movies. 

The role of Power Point is to Make your presentation more interesting to improve the 

audience's focus. PowerPoint allows you to use images, audio and video to have a greater 

visual impact. These visual and audio cues may also help a presenter be more 

improvisational and interactive with the audience. 

o Power Point Environment 

PowerPoint window is very similar to other Microsoft application windows 

 

• Office button: is used to access some basic commands like Save, Save As, Print, New, 

Close, 

o Quick Access toolbar: Contains a set of commands that are frequently used 

like Save, Undo, Redo, New,  

o Title bar: The Title bar displays the name of the presentation on which you 

are currently working on and the default PowerPoint name like 
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(Reference: https://ecomputernotes.com/fundamental/introduction-to-computer/types-

of-computers) 

presentation1 that would change as soon as you save your file and give 

another name.  

• Minimize button: used to remove a window from view. While a window is 

minimized, its title appears on the taskbar 

• Maximize/ restore button: You use the Maximize button to cause a window to fill 

the screen. After you maximize a window, if you click the Restore button, the 

window returns to its former size. 

• Close button: used to exit window and program 

o Ribbon: is designed to help you quickly find the commands that you need to 

complete a task. Commands are collected together under tabs (Menus: 

Home, Insert, Animations, Slide show. 

o Slide: Slides appear in the center of the window. You create your 

presentation on slides. 

o Placeholders: are boxes with dotted outlines that appear when you create a 

new slide. They will contain title, text and any other objects you display on 

slide 

o Zoom: allows you to zoom in and zoom out on the window. Zooming in makes 

the window larger so you focus in on an object. Zooming out makes the 

window smaller so you can see the entire window. 

o View buttons: The View buttons appear near the bottom of the screen. You 

use the View buttons to change between Normal view, Slider Sorter view, 

and the Slide Show view. 

o Notes: You can use the notes area to create notes to yourself. You can refer 

to these notes as you give your presentation 

o Status bar: The Status bar displays the number of the slide that is currently 

displayed, the total number of slides 

o Outline Tab: The Outline tab displays the text contained in your presentation.  

o Slides Tab: The Slides tab displays a thumbnail of all your slides 
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 Activity 2: Guided Practice 

Task:  

You are a youth leader in your association, and you need the government to offer you some 

funds to support your project. With the guidance of your trainer, design a good presentation 

to the government official in charge of youth, convincing her why you need that fund. 

Note; Remember to include pictures because they speak louder than words. 

 

 Activity 3: Application 

Task: 

 

You are a hotel supervisor, and the owner requires you to make a quick presentation to show 

a group of visitors the services you offer within 10 minutes.  
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Topic 4.2. Management of a slide 

 Activity 1: Problem Solving 

Task:  

You are request to answer the following questions  

a. Where do you write all the stuff you need to write?  

b. Give a particular name that are used in the power point,  

c. Where do we find that particular thing we need? 

 

Key Facts 4.2 

• Creating a new presentation  

o Open PowerPoint 

o A blank title slide appears as the first slide in your presentation 

o Enter the information in the Click to Add Title text box and in the Click 

to Add Subtitle text box. 

After completing your title slide, you can create additional slides 

o Home tab 

o click new slide  button in the slides group 

o Click the layout you want 

After creating slides, if you want you can add text and modify text. 

• Inserting a slide 

o Select the slide you want your new slide to follow. 

o Select Home > New Slide. 

o Select a layout. 
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o Select the text box and type. 

 

• Modifying a slide 

o In the View tab,  

o click Slide Master. 

o In the thumbnail pane that contains the slide masters and layouts, 

pick the layout that has closest arrangement of placeholders.  

To change an existing layout, do one or more of the following: 

o To add a placeholder, on the Slide Master tab, 

o  click Insert Placeholder, 

o  and then select a placeholder type from the list. Click a location on 

the layout, 

o  and then drag to draw the placeholder. 

To rename the layout, in the thumbnail list of layouts, right-click the layout that you 

customized, and then click Rename Layout. 

In the Rename Layout dialog box, type a new name that describes the layout you’ve just 

created, and then click Rename. 

On the Slide Master tab, click Close Master View. 

https://www.researchgate.net/publication/334988420_Strategic_Management_Lecture_Slides 

 

 Activity 2: Guided Practice 

Task: 

With your trainer guidance preform the following tasks  

1. Write down the steps to insert slide number on presentation?  

2. Which shortcut key is used to start and exit from the slideshow? 

3. Write down steps on how you can customize slide layout 
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4. You have a meeting in certain company to present how ICT has recently changed 

working environment of workers, prepare a 20-minute presentation to use in that 

meeting including all the figures, graphs, and tables that can add more meaning to the 

presentation 

 

 Activity 3: Application 

Task: 

 

You are asked to make a good presentation that you will use in a certain meeting, and you 

have to have 15 slides in your PowerPoint package. Can you show the procedures you will 

pass through to add/insert a slide to use?  
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Topic 4.3. Insertion of Graphics 

 Activity 1: Problem Solving 

Task: 

1. Think about how to insert an image/picture into a slide? 
a. How the graphics are inserted in a PowerPoint slide explain? 

b. How do you apply graphics styles in PowerPoint? 

c. What are the types of graphics that can be inserted in a PowerPoint? 

 

Key Facts 4.3 

• Inserting graphics 

o Insert Images from file 

If you want you can include images from the web or other sources in your presentation 

Click the slide which you wish to insert the image 

 On the Insert tab, choose Picture in the illustrations group 

 Navigate to the folder or drive in which you file is saved 

 Click the image file to select it 

 Click Insert button 

 The image will appear in the slide 
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o Inserting a Picture 

 

 

The picture will appear on the currently selected slide. 

 

In Office 2013 and Office 2016, there's no longer a clip art library, 

but Office still helps you insert clip art. 

 Select Insert > Online Pictures. 

 Type a word or phrase to describe what you're looking for, then press 

Enter. 

 Filter the results by Type for Clipart. 

 Select a picture. 

 Select Insert. 
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o Inserting WordArt,  

Follow these steps: 

 On the slide on which you want to insert WordArt,  

 click the Insert tab on the Ribbon and  

 then click the WordArt button in the Text group. 

A gallery of WordArt styles is displayed, as shown 

 
 

 

o Select the WordArt style you want to use. 

The WordArt text box is inserted on the slide, as shown here. 

 Click the WordArt text box  

 Then type the text you want to use. 

 Apply any other WordArt formatting you want. 
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 Activity 2: Guided Practice 

Task: 

 

Guide your trainer guidance to perform the following  

 

1. How to Insert a Picture in MS PowerPoint? 

2. Write down the steps to insert online pictures                 

3. Which steps to follow when Inserting screenshots        

4. How you can insert online video in PowerPoint 

 Activity 3: Application 

Task: 

You are using PowerPoint to make a good presentation that you will use in a certain meeting 

to demonstrate how the hotel suite is very suitable for all customers. You have to add pictures 

to show the surroundings of the hotel, but don't go beyond 10 slides 
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Topic 4.4. Conversion word documents to PowerPoint presentation 

 Activity 1: Problem Solving 

Task: 

You have been working on a Word document that you have to present to your superior as a 

site engineer. Your Word document comprises all the working materials, the number of skilled 

and unskilled labor force required on the construction site to ensure smooth operations, and 

the essential resources that need to be purchased to start the construction process. You need 

to present all this information to the board of directors in charge of the construction site; 

a. In a group of three discuss within 10minutes how you can convert that word document 

to PowerPoint, remember you have a limited time don’t start from scratch because 

the board of directors are already waiting for you in the board room 

b. Write down all your findings and share them with group next to you and see what you 

can improve on the steps you wrote down. 

 

Key Facts 4.3 

• Co    Converting word documents to PowerPoint presentation  

 

o Copy, cut and move 

 

 Copy: The cut command removes the selected data from its original 

position, while the copy command creates a duplicate; in both cases the 

selected data is kept in temporary storage (the clipboard). The data from 

the clipboard is later inserted wherever a paste command is issued. 

 Cut: The Cut command is used to remove text or images from the screen 

you are currently working on. "CUT" moves the information to your 

virtual clipboard, where it is stored until it is overwritten by the next 

"cut" or "copy" command. 
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 Move: move is really a copy, because at the end of the move, source and 

destination data are identical. 

o IMPORT FILE 

Import slides: Add slides from another presentation to your current slide deck. 

There are two ways to insert content objects into a PowerPoint presentation: 

o Linked objects    A linked object is updated if its source file is changed. For 

example, a linked chart built from data in Microsoft Excel is changed if the 

source Excel data changes. The source file must be available on your computer 

or network to maintain the link between the inserted object and the source 

data. Inserting a linked object is recommended if the source data set is large or 

complex. 

 Click in the slide where you want to place the object. 

 On the Insert tab, in the Text group, 

  click Object. 

 

 Click Create from File. 

 

 In the File box, type the name of the file, or click Browse to select from 

a list. 
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 Select the Link check box. 

Do one of the following: 

 To display the content in your presentation, clear the Display as 

icon check box. 

 To display an icon that is clicked to view the object, select the Display 

as icon check box. 

 To change the default icon image or label, 

  click Change Icon, and then click the icon that you want from 

the Icon list.  

 If you want, you can type a label in the Caption box. 

o Embedded objects:    the source data is embedded in the presentation. You can 

view the embedded object on another computer, because the source data is part of 

the presentation file. Embedded objects typically require more disk space than 

linked objects. 

 Click in the slide where you want to place the object. 

 On the Insert tab, in the Text group, 

  click Object. 

 

Do one of the following: 

If the object does not already exist,  

 click Create new.  

 In the Object type box,  

 click the type of object that you want to create. 

If the object already exists,  
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 click Create from file. 

  In the File box, type the name of the file,  

 or click Browse to select from a list. 

  Clear the Link check box. 

Do one of the following: 

 To display the content in your presentation,  

 Clear the Display as icon check box. 

 To display an icon that is clicked to view the object,  

 Select the Display as icon check box. 

 To change the default icon image or label,  

 Click Change Icon, and  

 Then click the icon that you want from the Icon list.  

 If you want, you can type a label in the Caption box. 

 

 

 Activity 2: Guided Practice 

Task:  

1 with the trainer guidance perform the following task in relation with how export a 

Word document to PowerPoint 

a. What are the steps to export word document to PowerPoint 

b. Whit an example for your choose follow all the  steps  
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 Activity 3: Application 

Task:  

 

You are request to create an engaging introduction to capture the interest of your audience 

early on in the presentation for that  

 

a. Explain the importance of a solid start to a presentation,  

b. Explain how to start a presentation and share examples and tips to help you begin. 
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Topic 4.5. Animation of a Presentation document 

 Activity 1: Problem Solving 

Task: Explain the process to insert an animation to presentation document. 

Key Facts 4.4 

     Animation 

 This is a method by which still figures are manipulated to appear as moving 

images. 

o Custom Animation 

A set of effects which can be applied to objects in PowerPoint so that they will 

animate in the Slide Show.  

o How to Apply a Custom Animation effect 

 Select the text or object. 

 Select the Animation tab. 

 In Animation group click the Custom Animation. 

 Custom Animation task pane appears on the right. 

 Click the Add Effect, it will display four options that are further divided 

into different options. 

 Select the desired effect. 
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https://foresternet.lakeforest.edu/live/files/advanced-powerpoint-features.pdf 

https://www.researchgate.net/publication/242106468_On_creating_animated_presentations 

 

 Activity 2: Guided Practice 

Task: 

 

You are asked to add animation and effects to text, pictures, shapes, and objects in your 

PowerPoint presentation. With the trainer's guidance, you will follow the process below:  

a. Select the object or text you want to animate. 

b. Select Animations and choose an animation. 

c. Select Effect Options and choose an effect. 
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 Activity 3: Application 

Task: 

You are using PowerPoint to create a presentation for a certain meeting, demonstrating how 

the hotel suite is very suitable for all customers. You are asked to add animations to showcase 

the surroundings of the hotel. The PowerPoint presentation should aim to attract customers 

to the hotel. Keep the presentation to a maximum of 10 slides. 
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Topic 4.6. Use of different presentation view 

Activity 1: Problem Solving 

Task:  

1. You have been selected to sensitize the public about the introduction of Subsidiary ICT 

at A-level. Use presentation software to deliver your presentation with the following 

content: 

a. Slide 1: A presentation title in word art format and you as the presenter.  

b. Slide 2: An introduction about the Subject  

c. Slide 3: Use bullets to outline the reasons for studying the subject.  

2. Then choose the right view from the task in PowerPoint 

Key Facts 4.6 

Use of different presentation view 

o Normal view 

Normal view is the editing mode where you’ll work most frequently to create 

your slides. Below, Normal view displays slide thumbnails on the left, a large 

window showing the current slide, and a section below the current slide where 

you can type your speaker notes for that slide. 

 



145 
 

o Slide Sorter view 

You can get to Slide Sorter view from the task bar  at the bottom of the 

slide window, or from the View tab on the ribbon. 

Slide Sorter view (below) displays all the slides in your presentation in 

horizontally sequenced, thumbnails. Slide show view is helpful if you need to 

reorganize your slides—you can just click and drag your slides to a new 

location, or add sections to organize your slides into meaningful groups. 

 

o Slide Show view 

You can get to Slideshow view from the task bar  at the bottom of the 

slide window. 

Use Slide Show view to deliver your presentation to your audience. Slide Show 

view occupies the full computer screen, exactly the way your presentation will 

look on a big screen when your audience sees it. 

o Presenter view 

To get to Presenter view, in Slide Show view, in the lower left corner of the 

screen, click , and then click Show Presenter View (as shown below). 
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Use Presenter view to view your notes while delivering your presentation. 

In Presenter view, your audience cannot see your notes. 

 

https://augustana.net/Documents/its/documentation/office2007/PowerPoint/PowerPoint%202007%20Different%20Views

.pdf 

https://www.familyhistoryfederation.com/_resources/presentation/presenter-view-for-your-power-point-presenation.pdf 
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 Activity 2: Guided Practice 

Task: 

 

1. Observe the figure and name the part to the corresponding letter, the 

trainer will assist you  

Latter Name descriptions 

A   

B   

C   

D   
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Activity 2: Application 

Task:  

1. The Ministry of health has appointed you as an educator. You are required to give a 

talk on “Role of Sex Education in Schools” 

You are required to design a three slides presentation as follows: 

a. Slide I - Should have the introduction of the Topic. 

b. Slide II - Should have the content of the Topic. 

c. Slide III- Should have relevancy of sex education in schools. 

d. Include your name and Personal number at the end of each slide. 

e. Save your presentation as “My Slide” 

f. Use minimal graphic effects. 

2. Malaria is one of the major killer diseases in Tropical Countries. As an informed 

person, you are required to design a slide show on malaria, the killer: Create four 

slides presentation: 

a. Slide I – should elaborate on the causes. 

b. Slide II – Should focus on the spread 

c. Slide III – Should show the prevention methods. 

d. Use minimal graphics in the three slides 

e. Slide IV – Should show an illustration using clip art picture related to 

malaria on the right-hand side with related text on the left-hand side. 

f. Link one slide to another. 

g. Save your work in personal folder on the desktop as “Malaria”  
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Topic 4.7. Print a presentation document 

 Activity 1: Problem Solving 

Task:  

In a group of four come up with the answers to the following questions; 

a. How do I Print an entire PowerPoint presentation? 

b. How do I Print a PowerPoint presentation over multiple pages? 

c. How do I Print a PowerPoint presentation as a PDF? 

Key Facts 4.7 

Printing a presentation document 

 

o Print preview 

Print preview is a feature that displays on the screen what a hard copy would 

look like when printed. 

After launching Microsoft PowerPoint 2010/2007, just click Print 

Preview button on classic style toolbar. Only one click is enough! 

 
Figure 1 

 After click the Print Preview button,  

 the PowerPoint 2007, 2010, 2013, 2016, 2019 and 365 interfaces will 

jump to the backstage view under File tab automatically. 

  At right side you will view the preview area. 
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Figure 2 

Step 2: 

  Get Print Preview with classic menus if you have Classic Menu for 

Office 

 Select the File drop down menu in main menus; 

 select the Print Preview item; 

 Then PowerPoint 2007, 2010, 2013, 2016, 2019 and 365 interface will 

jump to the backstage view, just the same as figure 2. 

 
o Printing a copy or multiple copies 
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Print your presentation 

 Select File > Print. 

 For Printer, select the printer you want to print to. 

 For Settings, select the options you want: Print All Slides: To print 

each slide on a single sheet or change to just print a range of slides.  

 For Copies, select how many copies you want to print. 

 Select Print. 

 

o Printing one slide on a page 

 Select File > Print. 

 For Printer, select the printer you want to print to. 

For Settings, select the options you want: 

 Print All Slides: To print each slide on a single sheet or change to 

just print a range of slides.  

 Slides: From the drop-down, choose to print all slides, selected 

slides, or the current slide. Or, in the Slides box, type which slide 

numbers to print, separated by a comma. 

 Print Layout: Choose to print just the slides, just the speaker 

notes, an outline, or handouts. The number of slides per page is 

also an option, an effective way to save paper.  

The Outline prints only the text in the slides, without images. The 

Notes of a presentation show the slide and the related speaker 

notes below it. If you choose to print Handouts, you can print 

several slides on one page using a variety of layouts, some with 

space for note-taking. 

 Color: Choose whether you want color, grayscale, or pure black 

and white.  

 Edit Header & Footer: Select to edit the header and footer before 

printing. 
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For Copies, select how many copies you want to print then; Select Print. 

• Print Multiple PowerPoint Slides on one Page 

 In PowerPoint, with your presentation open,  

 click File then Print. 

 In the Print window, in the Settings section, 

  click the Full-Page Slides drop-down menu. 

In the Handouts section of the drop-down menu, choose a multiple slide 

handout. 

 If you want to take notes on your printouts,  

 choose 3 slides.  

 This will give you lines to the left of each slide for in-class 

notes. 

 The most common used layouts are 4 slides and 6 slides per 

page. 

 Click Print to print your document. 

 Activity 2: Guided Practice 

Task: 

1. Create a PowerPoint presentation that contains your information, images, and links to 

your social media. Afterward, print your presentation. From the work list, explain the 

steps that you have used to print your presentation. 

2. Think of a poem in a group of four trainees write it well and after we need the hard 

copy of it 

a. Create a PowerPoint presentation that contains your information and images 

about it and link it to your social media 

b.  Print your presentation 

c. Explain steps that you have used to print your poem 
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 Activity 2: Application 

Task:  

You are an assistant to a certain hotel, and they need to advertise all about the hotel using 

hard copy pictures  

a. Where can you get them? 

b. Before printing what will you do to make sure they are ok 

c. Which type of paper will you print the pictures from 

d. What component will assist you to print them 

e. In case you have printed the picture upside down how can you solve the 

problem that will never happen again 

f. In case you picture don’t fit on the paper come up with the solution. 

Formative Assessment  

1. Which menu will you find the Print command? 

a. File 

b. Home 

c. Review 

d. View 

e. Print 

2. Which statement is true in reference to printing in PowerPoint? 

a. You can print 1-sided or back-to-back. 

b. You can collate while printing. 

c. You can print in black and white or color. 

d. You can print specific slides or all slides. 

e. All answers are correct. 

3. To print the first 10 slides of a presentation, you would add the range to the Slide box. 

What format would you use? 
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a. 1,10 

b. 1/10 

c. 1*10 

d. 1-10 

e. 1=10 

4. How Can You Change Color in Your Presentation All It Once Without Changing the 

Design 

a. Apply a Color Template 

b. Apply a Color Theme 

c. Apply a Color Palette 

5. Which Function Key Can Be Used to Begin the PowerPoint Presentation? 

a. F7 

b. F6 

c. F5 

d. F2 

6. How Can You Change the Appearance of a Table in One Click? 

a. Apply a table style 

b. Apply a cell style 

c. Apply a graphic style 

7. Which Statement About Saving PowerPoint File as PDF Is True? 

a. You can define the resolution of images as part of PDF export 

b. You can't compress the images during the export 

c. You can select an option File->Save As to save Black & White PDF 

8. Which arrow option choice will hide all mouse curser when presenting, except when 

the curser is moved? 

a. Automatic 
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b. Visible 

c. Hidden 

9. Which statement about the compress picture command is true? 

a. You can expand the cropped area for the picture 

b. You can compress all pictures at the same time 

c. You can improve quality as part of picture compression 

d. You can compress selected images on multiple slides 

10. When creating a new presentation, you begin with one blank slide. what is the 

layout name of this is 

a. Black 

b. Title slide 

c. Title and content 

d. Title only  

11. Which of the following is the default page setup orientation for slides in PowerPoint? 

a. Vertical 

b. Landscape 

c. Portrait 

d. None of above 

12. Which PowerPoint feature adds special effects to modify the appearance of the slides 

and the timing between each slide? 

a. Color Schemes 

b. Animation 

c. Transition Settings 

13. Which of the following section does not exist in a slide layout? 

a. Titles 

b. Lists 
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c. animations 

14. Which command brings you to the first slide in your presentation? 

a. Next slide button 

b. Page up 

c. Ctrl + home 

d. Ctrl + end 

15. The toolbars that are displayed by default in the PowerPoint window includes 

a. Menu bar, standard toolbar, formatting toolbar, drawing toolbar, status bar 

b. Menu bar, standard toolbar, formatting toolbar, drawing toolbar, status bar 

c. Standard toolbar, formatting toolbar, drawing toolbar, status bar 

d. Menu bar, standard toolbar, status bar, drawing toolbar 
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Self-Reflection 

1. Ask learners to re-take the self-assessment at the beginning of the unit. They should 

then fill in the table in the Trainee’s Manual to identify their areas of strength, areas 

for improvement and actions to take to improve.  

My experience I don’t have any 

Experience doing 
this 

I know a 

little 

about this 

I have some 

experience 

doing this 

I have a lot 

of 

experience 

with this 

Knowledge, skills and 

attitudes 

Create new presentation      

Explain the Blank 

presentation and Design 

template  

    

Create a slide     

Insert a slide      

Modify a slide     

Describe a Clip Art and a 

Word Art 

    

Describe Library Images     

Insert image from file     

Describe Copy, cut, move      

Describe Import file      

Explain Process of conversion      

Describe Animation      

Explain Custom animation      
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Describe Slide transition     

Describe Normal view      

Explain Slide sorter view      

Explain Slide show     

Describe Print preview      

Print a copy or multiple 

copies  

    

Print one slide on a page      

Print more slides on a page     

 

2. Discuss trainees’ results with them. Identify any areas that are giving many trainees 

difficulties and plan to give additional support as needed (ex. use class time before 

you begin the next learning outcome to go through commonly identified difficult 

concepts) 

Areas of strength Areas for improvement Actions to be taken to 

improve 

1. 

 

2. 

1. 

 

2. 

 

1. 

 

2. 
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Points to Remember 

● Choose readable colors and fonts 

● Don't forget your audience 

● Don't overload your presentation with animations 

● Choose a font style that your audience can read from a distance 

● Keep your text simple and minimize the amount of text on your slides 

● Make slide backgrounds subtle and keep them consistent 

● Use of different presentation view 

● Use high contrast between background color and text color 

● Check the spelling and grammar 

Table 15:LU.4 Points to Remember  
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UNIT 5: USE OF INTERNET/INTRANET (OUTLOOK)  

 

Unit summary: 

This unit describes the use of websites, search engines, use of instant messaging, 

management of favorites using internet explorer, how efficiently to use the internet and 

downloading as well as uploading files using the internet. 

 

 

  

                                                             
15 Cited by https://www.just.edu.jo/~mqais/cis99/PDF/Internet.pdf 

 
Figure 15: Illustration of internet; https://www.just.edu.jo/~mqais/cis99/PDF/Internet.pdf15 
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Self-Assessment: Unit 5 

1. Fill out the self-assessment below truthfully. 

It is for your own interest to figure out your weakness and take necessary 

action during this unit. Think about yourself: do you think you can do this? 

How well? Read the statements across the top. Put a check in column that 

best represents your situation. At the end of this unit, you will take this 

assessment again. 

. 

My experience I don’t have 

any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have some 

experience 

doing this.   

I have a lot 

of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Describe a website      

Explain types of websites      

Parts of website address      

Explain engines types       

Use of search engines       

Give examples of search 

engine 

     

Outline steps to create a 

chat account  

     

Describe the Chatting 

options  

     

Describe the Instant 

messaging with or no 

webcam, calling and 

sending files 
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My experience I don’t have 

any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have some 

experience 

doing this.   

I have a lot 

of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Describe Favorites types 

of explorers  

     

Create of favorites      

Define hyperlink       

Explain parts of web 

browser  

     

List the examples of web 

browser 

     

Define different terms:      

Outline the steps of 

downloading files  

     

Outline the tips of 

uploading files 

     

 

Key Competencies of Learning Unit 5: 

Knowledge Skills Attitudes 

1. Describe a website 1. Identify website 1. Creativity and 

understanding 

2. List types of websites 2. Explain of the types 

of websites 

2. understanding 

3. Explain parts of website 

address 

3. Identify the parts of 

website address 

3. understanding 
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4. Describe Search engines 

types 

4. Identify types of 

search engine 

4. Understanding 

5. List Some examples of 

search engine 

5. Explain search 

engine examples 

5. Creativity 

6. Describe the Steps to 

create a chat account 

6. Identify the steps to 

create a chat account 

6. Understanding 

7. Explain the use of 

instant messaging with 

or no webcam, calling 

and sending files 

7. Apply the use of 

instant messaging 

with or no webcam, 

calling and sending 

files 

7. Creativity and 

understanding 

8. Create and use of 

favorites 

8. Perform the creation 

and usage of 

favorites 

8. Creativity 

9. Define of hyperlink 9. Describe hyperlink 9. Understanding 

10. Explain basic parts of 

web browser 

10. Identify basic parts of 

Web browser 

10. Creativity 

11. Use of web browsers 11. Explain the use of 

web browsers 

11. Creativity 

12. Define downloading, 

Uploading, and File 

attachment 

12. Describe 

downloading, 

uploading, and file 

attachment 

12. Creativity 

13. Describe steps of 

downloading and 

uploading a file 

13. Perform steps of 

downloading and 

uploading a file 

13. Understanding 

Table 16:LU.5: Key Competences 
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  Discovery activity 

 

Figure 16: https://www.istockphoto.com/illustrations/family-internet 

Task; 

Look the pictures above and answer the questions  

a. How many times have you heard the phrase 'Google it'? 

b. Can you ‘Google it’ without internet connection? 

c. Where do we pass to find something over the internet? 

d. Name given to the particular thing that help us find a lot of things over the internet? 
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Topic 5.1: Description of a website 

  Activity 1: Problem Solving 

Task:  

What actually is an internet search engine, and how can it be used to help you with your 

English Language research?  

Key Facts 5.1 

• Description of a website 

o Introduction to a website 

A website is a collection of Web pages and related content that is identified by a common 

domain name and published on at least one Web server. 

o Definition of terms 

 Internet: a global computer network providing a variety of information 

and communication facilities, consisting of interconnected networks 

using standardized communication protocols 

 web browser:  is application software for accessing websites. When a 

user requests a web page from a particular website, the browser 

retrieves its files 

 Search engine: s a software system designed to carry out web searches. 

They search the World Wide Web in a systematic way for particular 

information 

o Types of websites 

 Dynamic: is one with stable content, where every user sees the exact 

same thing on each individual page. On the other hand 
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 Static: is one where content is pulled on-the-fly, allowing its content to 

change with the user. 

o Parts of website address 

 HTTP: is an application-layer protocol for transmitting hypermedia 

documents. 

 WWW: is an information system enabling documents and other web 

resources to be accessed over the Internet. Documents and 

downloadable media are made available to the network through web 

servers and can be accessed by programs such as web browsers. 

 Domain name of website: is a unique, easy-to-remember address used to 

access websites, such as ‘google.com’, and ‘facebook.com’. Users can 

connect to websites using domain names thanks to the DNS system 

 Domain name suffix:  the last part of a domain name and is often 

referred to as a "top level domain" or TLD, Popular domain suffixes 

include ".com," ".net," and ".org," but there are dozens of domain 

suffixes approved by ICANN. 

 Activity 2: Guided Practice 

Task: 

1. People are known days getting everything from the internet, all needed either at work 

place nor at school’s internet is very essential; 

a. What do they use to browse or search for something 

b. How do they use them? 

c. Website are becoming many on the internet, think about online services that 

all people like to access most time. Give five examples of web sites and explain 

their corresponding services.  
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 Activity 3: Application 

Task: 

Julia is considering a trip across the United States this fall. She would like to check out the 

scenery, of course, and maybe stop at a few important landmarks along the way. She doesn't 

have any particular preference about which states she visits, but she is trying to travel as 

economically as possible. 

a. Can you help Julia with her search? 

b. What types of keywords would help Julia with the sight-seeing portion of her 

trip? 

c. Taking Julia's expenses into account, what types of keywords might help refine 

her web search?  
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Topic 5.2 Using Search Engines (Example Google) 

 Activity 1: Problem Solving: 

 Task: 

1. Dennis has been sitting in the waiting room at ABC City Hospital for the past two hours. 

He hasn't been feeling well and thinks that he might have the flu. He can barely keep his 

eyes open, but he's also bored and looking to pass the time. After catching up on his 

smartphone games, he decides the next best option is to read the latest headlines and 

hottest news stories. What would you recommend for Dennis in this situation? Give 

answers to questions below; 

a. How can Dennis approach his search for top headlines 

b. Are there other options available to him? 

2. Why would a web portal be better than a search engine in this example? 

a.   What is a search engine? 

b. What are the 5 advantages of using search engines? 

Key Facts 5.2 

• Using search engines 

o Description of search engine 

A search engine is a software program that helps people find the information they are 

looking for online using keywords or phrases. They provide users with search results that 

lead to relevant information on high- quality websites. The operative word here is 

"relevant". To attain and retain market share in online searches, search engines need to 

make sure they deliver results that are relevant to their users’ searches. They do this by 

maintaining databases of web pages, which they develop by using automated programs 

known as "spiders" or "robots" to collect information. These algorithms are jealously 
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guarded and frequently updated. Google looks at more than 200 different metrics when 

assessing websites, including copy, in-bound links, website usability and information 

architecture 

o Search engines type 

There are four (4) main types of search engine tools: 

 based search engines 

 Search directories or indexes 

 Hybrid search engines 

 Meta search engines 

o Role of search engines 

 A search engine is a software program that helps people find the 

information they are looking for online using keywords or phrases. 

 Search engines are able to return results quickly 

 even with millions of websites online 

 by scanning the Internet continuously and indexing every page they 

find. 

o Some examples of search engine 

 Google 

 Amazon 

 Yahoo! 

 Bing 

 Baidu  

 AOL. 
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 Activity 2: Guided Practice 

Task:  

1. What happens when a search is performed in one of the search engines? 

When a search query is entered into a search engine by a user, all of the pages which are 

deemed to be relevant are identified from the index and an algorithm is used to 

hierarchically rank the relevant pages into a set of results. The algorithms used to rank 

the most relevant results differ for each search engine. For example, a page that ranks 

highly for a search query in Google may not rank highly for the same query in Bing. In 

addition to the search query, search engines use other relevant data to return results, 

including: 

a. Location – Some search queries are location-dependent e.g. ‘cafes near me’ or 

‘movie times’. 

b. Language detected – Search engines will return results in the language of the 

user, if it can be detected. 

c. Previous search history – Search engines will return different results for a 

query dependent on what the user has previously searched for. 

d. Device – A different set of results may be returned based on the device from 

which the query was made.  

2. Kaitlyn is out of town, exploring the great southern city of Charleston, South Carolina. 

She has taken in a lot of the local sights and explored a little bit of the town's history. 

Now, it's approaching lunch time, so Kaitlyn and her friends are trying to decide where 

to find the best soul food restaurants in the city, so they can all grab a bite to eat. 

a.  How would you approach this situation? 

b. Should Kaitlyn use a search engine or a web portal? 

c. What type of keywords should she choose? 

d. Why should she choose those keywords?  
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 Activity 3: Application 

 Task: 

1. What can I read on the field of news and search engine results page? 

2. I am looking for a software for searching a text in a set of files. Any recommendations? 

3. Describe in brief how to Improve search techniques and data processing on the 

Internet? 

4. The Internet search engine is a tool that Internet users often use nowadays. Does this 

tool fully meet the expectations of Internet users? How can the search engines currently 

used by Internet users be improved?  
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 Topic 5.3. Using Instant Messaging (Chatting) 

 Activity 1: Problem Solving 

 Task:  

1. Sarah and Peter want to chat using instant messaging tools. Sarah has an active 

Gmail account, while Peter has an active Yahoo account. Sarah is trying to send a 

Google Talk message to Peter but couldn’t send it. 

a. Why couldn’t Peter receive message from Sarah 

b. Describe the best communication they could use? 

2. Provide a possible solution to this  

a. What are some instant messaging systems? 

b. What are instant messaging advantages 

c. What are instant messaging disadvantages 

d. How to overcome the disadvantages of instant messaging for business? 

Key Facts 5.3 
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• Instant messaging (chatting)   

Chat and instant messaging (IM) are short messages sent and read in real time, allowing 

you to converse more quickly and easily than email. 

o Steps to create a chat account 

 Go to your dashboard, 

  choose Live Chat,  

 and click Create a new chatroom 

 Give it a Name  

 and choose the status Live or Closed (end-users can´t send messages). 

Then jump to the Advanced Settings, for example: 

o Language - we support 18 Languages  

o Pre-Moderation - Messages must be manually approved before appearing 

to the public 

o Sign Up Settings - You can choose to make the sign-up required, not 

required (or suggested), and integrate Single Sign-On on your account. 

o Profanity filter - Block, Replace message with ***, or None 

o Once you are ready, click Start Chatting. 

o Chatting options 

 Help Scout                     Thankful AI 

  Olark                              Pure Chat   

 Live Chat                           

 Acquire 

o Instant messaging with or no webcam, calling and sending files 

Send an instant message to one person 

 Sign in to Lync. 

 On the Contacts tab, do one of the following: 
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To send a message 

to 

Do this 

An existing contact 

who is online 

Double-click the contact. 

Available contacts display a green bar   or icon. 

A person who is not 

in your contact list 

On the Contacts tab, in the Find a contact or dial a 

number box, type the person's e-mail address, and then 

double-click the contact. 

To add this person as a contact, click the person's avatar in 

the conversation window, and then click  . 

In the lower part of the conversation window, type your message, and then press 

RETURN. 

Notes:  

 You can add contacts to a conversation. However, you must start the 

conversation with a single contact. 

 Each message can be up to 8,000 characters long. 

o Add more contacts to a conversation 

After you start a conversation, you can invite additional contacts to join. 

 In the conversation window, on the      pop-up menu, click Invite by 

Name or Phone Number. 

 Select the contact who you want to invite, and then click OK. 

Notes:  

 To invite a person who is not in your contact list, in the search box, type 

the person's e-mail address or phone number. 
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 A total of 100 people, including you, can take part in a conversation. 

o Receive an instant message invitation 

When someone sends you an instant message, an instant message alert appears in the 

bottom-right corner of your computer screen. 

 Click Accept in the invitation alert. 

 In the conversation window, type your response in the message area, 

and then press RETURN. 

o Make an audio call in Lync 

You can use Lync for Mac to talk to contacts in your network. You can also conduct 

conference calls by inviting multiple contacts to join the conversation. During an audio 

call, you can also use Lync to send files and text messages. 

To use audio calling, both you and your contact must have a microphone and either 

speakers or headphones. If your computer doesn't have a built-in microphone, you can 

purchase a Mac-compatible microphone for your computer. To learn about how to set 

up these devices, see Mac Help. 

o Do any of the following: 

To Do this 

Call a contact not in your 

contact list or to call a 

contact's alternate 

number 

On the Phone tab, in the Dial a phone number box, 

enter a phone number or an alphanumeric number on 

the keypad. 

Call a contact in your 

Contact List 

On the Contacts tab, select a contact, and on 

the Contact menu, click Call, and then click the number 

that you want to call. 

 After your contact accepts the call, talk into the microphone. 
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 Do any of the following: 

To Do this 

To invite other contacts to the 

audio call 
On the     pop-up menu, click Invite by Name or 

Phone Number, and then either select the contact 

you want, or in the search box, enter a phone 

number or e-mail address. 

Add video to the call Click  . 

Adjust the volume Drag the volume slider  . 

Put the audio call on hold so 

that no sound is sent or 

received 

Click   . 

Transfer the call 
Click  , click Other Person or Number, and then 

either select the contact you want, or in the search 

box, enter a phone number or e-mail address. 

End the audio part of the call 

but leave the message window 

open 

Click   . 

Use the touchtone feature 

while in a call 
Click . 

Mute the call Click  

Leave the conversation 

completely 

Close the conversation window. 
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Make a video call in Lync 

You can use Lync for Mac to make video calls to contacts in your network. You can also 

conduct video conference calls by inviting multiple contacts to join the conversation. 

During a video call, you can use Lync to send files and text messages. 

To use video calling, both you and your contact must have a webcam, a microphone, and 

either speakers or headphones. If your computer doesn't have a built-in webcam and 

microphone, you can purchase a Mac-compatible device to attach to your computer. To 

learn about how to set up these devices, see Mac Help. 

 On the Contacts tab, select a contact, and on the Contact menu, click Start a 

Video Call. 

 After your contact accepts the call, talk into the microphone. 

 Do any of the following: 

To Do this 

Invite other contacts to join the video 

call 
On the     pop-up menu, click Invite by 

Name or Phone Number, and then either 

select the contact you want, or in the 

search box, enter a phone number or e-

mail address. 

End the video and audio parts of the 

call, but leave the message window 

open 

Click   . 

Put audio and video on hold or resume 

a call 
Click   . 

Change the video to full-screen mode 

or back to regular size 
Click . 
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Mute or unmute your microphone Click   . 

Adjust the volume Drag the volume slider  . 

Show or hide all participants or yourself 

during a conversation 
Click  . 

Change to an audio-only call Click  . 

Leave the conversation completely Close the conversation window 
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 Activity 2: Guided Practice 

Task:  

With your trainer guidance or assistance perform the following  

1. In details explain the difference between Email and Instant messaging 

2. Stella has an active account on Yahoo; what instant messaging software or tools can she 

use without creating any other accounts 

3. Explain any four features of instant messaging 

4. open your instant messaging app and start communicating with your friend.  after that fill 

the table according to the communication tool you are using; 

To Do this 

 Click   . 

 Click   . 

 Click . 

 Click   . 

 Drag the volume 

slider  . 

 Click  . 

 Click  . 
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 Activity 3: Application 

 Task:  

Instant Messaging (IM) is an electronic messaging service that allows users to determine 

whether a certain party is connected to the messaging system at the same time. IM allows 

them to exchange text messages with connected parties in real time.  

a. What do you understand by instant messaging account? 

b. Explain the steps to create instant messaging account 

c. What are the basic requirements for using Instant Messaging? 

d. You’re in a certain discussion and they are wondering if Instant Messaging has some 

rules that guide them if Yes What are some general rules and etiquettes to be 

followed while chatting? 
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Topic 5.4:   Management of favorites Using Microsoft Edge 

 Activity 1: Problem Solving 

Task: 

 

Answer the questions below  

 

a. How favorites are managed using Internet explorer 

b.  Describe the steps followed to create and Manage Favorites 

c. Where are favorites in Microsoft Edge? 

d. How to Organize Favorites in Microsoft Edge? 

e. How do I manage edge favorites in Group Policy? 

 

Key Facts 5.4 

• Favorites 

Favorites is a type of pining your favorite websites so that it is easy to access that 

website by a click rather than having to enter the whole website in the address bar. 

Internet Explorer allows you to add and manage favorites. 

o To add a favorite:  

 With the desired website open in your browser 

 Select the Favorites button, then click  

 Add to favorites.  

 You can also press Ctrl +D on your keyboard. 

 A dialog box will appear. 

 Click Add to save the website as a favorite 

When you add a website to your Favorites, or create a Favorites folder in Internet 

Explorer, you give it a particular name. 
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But what if you want to rename a shortcut or a folder after the fact? No problem 

there, Internet Explorer lets you easily rename bookmark titles and folder names. 

In this tutorial, we will explain how to perform both renaming operation 

o Rename a Favorite in Internet Explorer 

When you add a website to your Favorites, Internet Explorer will by default use the 

web page's title as Favorite name (and you have the option to type another name 

for the bookmark).  

As we'll see in the next tutorial, you can sort your Favorites by name, which is why 

we want to first show you how to rename a Favorites' bookmarked page. 

Since all versions of Internet Explorer, you are likely to use include a Favorites 

menu, let's start by showing you this approach to renaming a Favorite:  

click on the Favorites menu (or press Alt+A if it isn't visible), and locate the 

bookmark you want to rename. Then, right-click on it, and choose "Rename" from 

the context menu 

 
Internet Explorer will open the Rename dialog, which contains the current name of 

the Favorites bookmark: rename it by typing a new title under the new name 

textbox, and click OK to accept it.  

If you now check the Favorites menu, you will see that Internet Explorer has 

applied the new name to the bookmarked website / web page. 

o Rename a Favorite through the favorites Center 
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Internet Explorer 7 and Internet Explorer 8 include a new "Favorites Center", which 

replaces the Favorites menu to a great extent; click on the Favorites button (shown 

on screenshot). 

And same as before: locate the bookmarked page, right-click on it, and choose 

Rename! If you rename the folder through the Favorites Center, Internet Explorer 

will immediately let you type a new name for the folder, without prompt, by 

making the folder's name editable: Hit Enter to apply the new folder name. 

  Activity 2: Guided Practice 

Task:  
1. How do I increase the size of the Favorites Bar in Internet Explorer? 

2. How do I organize my favorites in Internet Explorer? Show all the steps 

3. What is the use of Favorites in Internet Explorer? 

4. If you cannot find Favorites bookmarking Icon in Internet Explorer, you will find below 

the steps to Fix the problem of Favorites Missing in Internet Explorer 

5.   How to organize favorites in Microsoft Edge?  



184 
 

 Activity 3: Application 

 Task: 

I have a new Dell with Windows 7 Professional and IE 11. I transferred all favorites from my 

old Dell without any problem. I have also downloaded Firefox as an alternate browser. I can 

save new favorites in Firefox without any problem, but when I try to save any new favorite in 

IE 11, I get an error message. The message says " unable to create - can't add to favorites 

windows select lounge". I have tried in Favorites Properties under location tab to "restore 

default" to no success.  

a. How can I resolve the issue? 
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Topic 5.5 Browsing on internet Using the Hyperlinks 

 Activity 1: Problem Solving 

Task;  

1. Describe the following; 

a. What is a hyperlink? 

b. What are the types of hyperlinks? 

c. Provide three examples of internet search engine 

Key Facts (Indicative contents) 

•  Hyperlink 

Definition of hyperlink 

This is an item like a word or button that points to another location. When 

you click on a link, the link will take you to the target of the link, which may 

be a webpage, document or other online content. Websites use hyperlinks as 

a way to navigate online content. 

• Basic parts of web browser 

Components of a Web Browser 

o User Interface. It is an environment allowing users to use certain 

features like search bar, refresh button, menu, bookmarks, etc. 

o Browser Engine. The bridge connects the interface and the engine. ... 

o Networking. 

o Data Storage.  

o JavaScript Interpreter 
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Examples of web browser  

o Mozilla Firefox: Mozilla Firefox, or simply Firefox, is a free and open-source 

web browser developed by the Mozilla Foundation and its subsidiary, the 

Mozilla Corporation. 

o Microsoft Edge. is a proprietary, cross-platform web browser created by 

Microsoft. It was first released in 2015 as part of Windows 10 and Xbox One 

and later ported to other platforms as a fork of Google's Chromium open-

source project: Android and iOS, macOS, older Windows versions,  

o  Internet Explorer: is a series of graphical web browsers developed by 

Microsoft which was used in the Windows line of operating systems. 

o Safari: Safari is a graphical web browser developed by Apple. It is primarily 

based on open-source software, and mainly Web Kit.  

Step 1: Using Internet Explorer 

o Go to your browser’s address bar and type in the address of the search engine 

website – for instance, https://www.google.co.uk 

Step 2: Using a search engine 

o All you have to do is enter some keywords in the space provided – called the 

‘search box’ – and then click Search. 
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o For example, if you put ‘holiday’ and ‘Mauritius’ into the search box and click 

Search, you’ll come up with page after page of companies offering holidays in 

Mauritius. 

o A search engine can be used to look for products, companies, people, 

information, images, directions and maps. You’ll never again be frustrated by 

having that answer on the tip of your tongue just Google the keywords 

 Activity 2: Guided Practice 

Task:  

1. You are requested to study the figure below and name the highlighted part 
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Fill the table below according to the figure above 

Latter Name Role 

A   

B   

C   

D   

E   

F   

G   

H   

 

a. What is the meaning of browsing the Internet? 

b. How to Manage web pages in a browser 

c. Differentiate between the three types of hyperlinks 

d. Clicking on a hyperlink can take you to which of the following locations? 

 Activity 3: Application 

Task:  

Your asked to answer the following questions  

1. From what you have learned from this topic using a web browser search your 

current location and screenshot the results. 

2. Use the practice questions on this quiz to test your knowledge of: 

a. What a hyperlink can be used for 

b. Where clicking on a hyperlink can take you to 
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c. How a hyperlink is depicted in a document 

d. Ways a hyperlink can be used without an Internet connection 

e. What happens to a mouse pointer when hovering over a hyperlink? 
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Topic 5.6 Downloading and Uploading files Using the Internet 

 Activity 1: Problem Solving 

Task: 

1. A certain trainee didn’t know the difference between uploading and downloading? On 

a half of paper can you explain how they differ from each other 

2. What are the things that you need to consider before downloading from the Internet? 

3. What is the difference between uploading and downloading? 

4. Why do you need to upload & download the files? 

5. What kind of files do we upload commonly? 

Key Facts 5.6 

Definition of terms:  

Downloading is the transmission of a file or data from one computer to another over a 

network, usually from a larger server to a user device.  

File Attachments are files embedded within online communication channels such as 

emails, instant messages, or social networks. File attachments can come in any form, such 

as images, documents, or programs. A paper clip image often symbolizes the presence of 

attachments in messages 

Uploading is the process of putting web pages, images and files onto a web server. 

• Steps of downloading files  

o Most files: Click on the download link. Or, right-click on the file and choose Save as. 

o Images: Right-click on the image and choose Save Image As. 

o Videos: Point to the video. Click Download.  

o PDFs: Right-click on the file and choose Save Link As. 
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o Webpages: At the top right, click More. More Tools. 

• Tips of uploading files 

Uploading files from your machine to a host machine is a two-step process: 

Step 1: Select a file from your machine to be uploaded. 

Step 2: Click the upload button 

• Selecting files 

Depending upon the browser you use, the screen for selecting file may look different. The 

following images display how file selection is performed on different browsers. 

Internet Explorer 

 

● Click the Browse button to 

choose a file. You also manually 

type a path, however, clicking 

the Browse button is strongly 

recommended to avoid typing 

incorrect value. 

● Once a file is selected, 

click Upload file 

Mozilla Firefox 

 

● This is similar to Internet 

Explorer.  

Click the Browse button to 

choose a file. The browser 

automatically opens 

the Browse window if you try 

to type anything in the text box. 

● Once a file is selected, 

click Upload file 
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Apple Safari 

 

● Unlike IE and Firefox, Apple 

Safari does not display a text 

box. Instead, it only contains a 

button that reads Choose 

File allowing the user to select a 

file. After selection, the file 

name is displayed in the text 

box on the side. 

● Once a file is selected, 

click Upload file 

Google Chrome 

 

● Google's browser behaves exactly 

like Apple Safari. It does not 

contain any text box and user 

must click the Choose File button. 

● Once a file is selected, click Upload 

file 

 

https://edu.gcfglobal.org/en/internetbasics/downloading-and-uploading/1/ 
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  Activity 2: Guided Practice 

Task: 

1. You’re a given a task in the worker place but you can use your computer to provide the 

solution quickly  

a. Describe all Steps to download that file  

b. Why uploading and downloading a file is required? Explain with example 

2. You’re given work to upload a new profile picture to your Facebook account. 

a.  List all steps that are followed to upload a photo to your Facebook  

b. Download one of your favorite songs from YouTube by using one of the internet 

download managers?  

 Activity 3: Application 

Task:  

You’re an intern your supervisor requires to show your workmates how downloading is done; 

a. Can you offer different tips to download something clear and first? 

b. Discuss the procedures you followed and upload anything to your Instagram 

account 
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Points to Remember 

 

• Don’t use common, easily guessable passwords. 

• When you sign up for something online, read the terms and conditions 

• Promptly install software updates, especially when they include important 

security upgrades. 

• Set up automatic updates on your devices so you never miss one 

• Back up important personal information on external hard drives 

• Create new back-ups regularly.  

• Practice Safe Browsing 

• Be Careful What You Download 

 

Table 17:LU.5 Points to Remember 

Self-Reflection learning unit 5 

Reflect on your achievement in the above learning Unit, base your reflection on activities 

done and your performance.  

My experience I don’t have 

any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have some 

experience 

doing this.   

I have a lot 

of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Describe a website      

Explain types of websites      

Parts of website address      

Explain engines types       

Use of search engines       
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My experience I don’t have 

any 

experience 

doing this. 

I know 

a little 

about 

this. 

I have some 

experience 

doing this.   

I have a lot 

of 

experience 

with this. 

I am 

confident 

in my 

ability to 

do this. 

Knowledge, skills and 

attitudes 

Give examples of search 

engine 

     

Outline steps to create a 

chat account  

     

Describe the Chatting 

options  

     

Describe the Instant 

messaging with or no 

webcam, calling and 

sending files 

     

Describe Favorites types 

of explorers  

     

Create of favorites      

Define hyperlink       

Explain parts of web 

browser  

     

List the examples of web 

browser 

     

Define different terms:      

Outline the steps of 

downloading files  

     

Outline the tips of 

uploading files 
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Fill the table below to identify your areas of strength, areas for improvement and actions to 

take to improve. 

 

Formative Assessment 

Choose the correct answer 

1. What is a search engine?  

a. A tool for searching the entire Internet. 

b. A tool to find information on your computer. 

c. A fast browser. 

d. A tool for searching a specific website. 

2. When searching the Internet, you can add words to the search terms. How do you 

do this? 

a. You can add a word from your search by putting a plus sign ("+") immediately 

in front of the term you want to include 

b. You can add a word from your search by capitalizing it in the search string. 

c. You can add a word from your search by putting a plus sign ("+") anywhere in 

the search string. 

d. You can add a word from your search by putting a plus sign ("+") immediately 

behind the term you want to include 

3. 3.  Which of these is the correct way to search for a phrase? 

a. How do I use a search engine? 

b. How do I use a search engine?” 

c. How do I, “Use a search engine?" 

Areas of strength Areas for improvement Actions to be taken to 

improve 

1. 

 

2. 

1. 

 

2. 

 

1. 

 

2. 
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d. Search engines, "How do I use one? 

4. Instant messaging also refers to __________. 

5.  __________ refers to sending message to someone online and get the immediate 

response 

6. You must need an account for using IMS. (True/False) 

7. You cannot send a message to offline users in a hangout. (True/False) 

8. When was Google founded? 

e. 1998 

f. 1999 

g. 2000 

h. 2001 

9. 9.Which of these is not among the Google operating systems? Android  

a. Chrome OS  

b. Wear OS 

c. Mac OS 

d. Android 

10. 10. When you mouse over a hyperlink, your pointer will likely turn into: 

a. A pointing finger 

b. A small car 

c. A cloud of dust 

d. A question marks 

11. 11. How could a hyperlink be used without an Internet connection? 

a. To link from one page to another in a Word document 

b. To link from one page to another in a PDF document 

c. To link from one document stored on your computer to another document 

stored on your computer 

d. All answers are correct 

12. Clicking on a hyperlink can take you to which of the following locations? 

a. Another place in the document you have open 

b. Another web site 

c. To another document other than the one you have open 

d. All choices are correct 
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13. ____ is a program that helps us to manage our files and folders. 

a. Windows 

b. Help 

c. DOS 

d. Windows Explorer 

14. The Explorer bar is divided into ___ categories. 

a. 2 

b. 3 

c. 5 

d. 7 
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